Using Charts
Using Subforms/Subreports
Using Other Form Techniques
Using PivotTables and PivotCharts
  Working with Indexes
Using Access and the Internet
Using Access Database Security
  Creating Macros
  Using Macros
Customizing the Navigation Pane
Collecting Data by E-mail
Exporting Data
ABOUT ONDEMAND SOFTWARE

The OnDemand Software Division of Global Knowledge is the worldwide leader of software solutions that enable rapid adoption, broad acceptance and increased accuracy in the use of enterprise applications related to enterprise resource planning, supply chain management, procurement, e-commerce and customer relationship management.

The flagship product, OnDemand Personal Navigator™, provides one synchronized documentation, training and performance support platform. Founded in 1986, the OnDemand Software Division has over 850 Global 2000 customers in 12 countries. The OnDemand Software Division of Global Knowledge, a Welsh, Carson, Anderson and Stowe portfolio company, is headquartered in King of Prussia, Pennsylvania, with offices located worldwide. Additional information can be found at http://www.ondemandgk.com.

COPYRIGHT

Copyright © Global Knowledge Software LLC. 2008. All rights reserved. Information in this document is subject to change without notice and does not represent a commitment on the part of Global Knowledge.

No part of this publication, including interior design, cover design, icons or content may be reproduced by any means, be it transmitted, transcribed, photocopied, stored in a retrieval system, or translated into any language in any form, without the prior written permission of Global Knowledge Network, Inc.

Products mentioned herein, including SAP R/3, PeopleSoft, Siebel Systems, Microsoft Windows, Microsoft Office, Microsoft FrontPage, Microsoft Outlook, Macromedia Flash, Adobe Acrobat, and JavaScript are trademarks or registered trademarks of their respective owners.

OnDemand Personal Navigator and Courseware Express are trademarks of Global Knowledge Software LLC. CustomDOC and Knowledge Pathways are registered trademark of Global Knowledge Software LLC. Global Knowledge and the Global Knowledge logo are trademarks of Global Knowledge, Inc.

DISCLAIMER

Global Knowledge has taken every effort to ensure the accuracy of this manual. If you should discover any discrepancies, please notify us immediately.

Global Knowledge Software LLC.
OnDemand Software Division
475 Allendale Road
King of Prussia, PA 19406
(610) 337-8878
www.ondemandgk.com
ABOUT ONDEMAND SOFTWARE .............................................................. I
COPYRIGHT .......................................................................................... I
DISCLAIMER ........................................................................................ I

LESSON 1 - USING CHARTS ................................................................. 1
  Working with Charts ......................................................................... 2
  Adding a Chart to a Form or Report .................................................. 5
  Using Microsoft Graph to Edit ......................................................... 7
  Changing the Chart Type ................................................................. 10
  Changing the Chart Title .................................................................. 12
  Formatting the Chart Title ............................................................... 13
  Adding Data Labels to a Chart .......................................................... 15
  Exercise ............................................................................................. 17
  Using Charts .................................................................................... 17

LESSON 2 - USING SUBFORMS/SUBREPORTS ...................................... 19
  Working with Subforms/Subreports ................................................... 20
  Creating a Subform/Subreport .......................................................... 21
  Editing the Layout of a Subform ....................................................... 24
  Displaying a Subform in Datasheet View ........................................ 26
  Displaying a Subform/Subreport Total ............................................. 27
  Exercise ............................................................................................. 31
  Using Subforms/Subreports ............................................................. 31

LESSON 3 - USING OTHER FORM TECHNIQUES ................................... 33
  Creating a Split Form ........................................................................ 34
  Converting an Existing Form to a Split Form .................................... 35
  Editing a Split Form ......................................................................... 36
  Adding a Command Button ............................................................. 38
  Saving a Form as a Report ............................................................... 41
  Exercise ............................................................................................. 44
  Using Other Form Techniques ......................................................... 44
LESSON 4 - USING PIVOTTABLES AND PIVOTCHARTS ................. 45
Creating a PivotTable View ........................................... 46
Creating a PivotChart View ........................................... 50
Exercise ........................................................................ 54
Using PivotTables and PivotCharts .................................. 54

LESSON 5 - WORKING WITH INDEXES ................................. 55
Viewing Indexes ................................................................ 56
Creating a Single Field Index ........................................... 57
Creating a Multiple Field Index ....................................... 59
Deleting an Index ............................................................ 61
Creating a Multiple Field Primary Key ............................... 63
Exercise ........................................................................ 66
Working with Indexes ..................................................... 66

LESSON 6 - USING ACCESS AND THE INTERNET .................... 67
Working with Hyperlinks .................................................. 68
Creating a Hyperlink Field .............................................. 68
Inserting a Hyperlink Field ............................................. 70
Editing a Hyperlink Field ............................................... 72
Deleting a Hyperlink Field ............................................. 73
Exercise ........................................................................ 75
Using Access and the Internet ......................................... 75

LESSON 7 - USING ACCESS DATABASE SECURITY .................. 77
Encrypting a Database with a Password ............................. 78
Opening and Decrypting a Database ................................ 80
Removing a Database Password ...................................... 81
Exercise ........................................................................ 83
Using Access Database Security ...................................... 83

LESSON 8 - CREATING MACROS ......................................... 85
Working with Macros ..................................................... 86
Opening the Macro Tools Window ................................... 86
Creating a Macro ........................................................... 88
Displaying Macro Design Arguments ............................... 92
Assigning an Argument to an Action ............................... 93
<table>
<thead>
<tr>
<th>Lesson</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Using Single Step Mode for Testing</td>
<td>98</td>
</tr>
<tr>
<td>9</td>
<td>Using Macros</td>
<td>107</td>
</tr>
<tr>
<td>9</td>
<td>Creating Embedded Macros</td>
<td>108</td>
</tr>
<tr>
<td>9</td>
<td>Assigning a Macro to a Control</td>
<td>108</td>
</tr>
<tr>
<td>9</td>
<td>Creating a Command Button</td>
<td>110</td>
</tr>
<tr>
<td>9</td>
<td>Adding a Condition to a Macro</td>
<td>113</td>
</tr>
<tr>
<td>9</td>
<td>Creating a Group Macro</td>
<td>116</td>
</tr>
<tr>
<td>9</td>
<td>Creating an Autoexec Macro</td>
<td>119</td>
</tr>
<tr>
<td>9</td>
<td>Exercise</td>
<td>125</td>
</tr>
<tr>
<td>9</td>
<td>Using Macros</td>
<td>125</td>
</tr>
<tr>
<td>10</td>
<td>Creating Custom Categories</td>
<td>127</td>
</tr>
<tr>
<td>10</td>
<td>Creating Custom Groups</td>
<td>128</td>
</tr>
<tr>
<td>10</td>
<td>Adding Database Objects to a Group</td>
<td>130</td>
</tr>
<tr>
<td>10</td>
<td>Showing/Hiding the Unassigned Objects Group</td>
<td>131</td>
</tr>
<tr>
<td>10</td>
<td>Deleting Objects from a Group</td>
<td>133</td>
</tr>
<tr>
<td>10</td>
<td>Exercise</td>
<td>134</td>
</tr>
<tr>
<td>10</td>
<td>Customizing the Navigation Pane</td>
<td>136</td>
</tr>
<tr>
<td>11</td>
<td>Understanding When to Use Data Collection</td>
<td>137</td>
</tr>
<tr>
<td>11</td>
<td>Using the Collect Data By E-mail Messages Wizard</td>
<td>138</td>
</tr>
<tr>
<td>11</td>
<td>Setting Data Collection by E-mail Options</td>
<td>138</td>
</tr>
<tr>
<td>11</td>
<td>Manually Processing Replies</td>
<td>143</td>
</tr>
<tr>
<td>11</td>
<td>Exercise</td>
<td>144</td>
</tr>
<tr>
<td>11</td>
<td>Collecting Data by E-mail</td>
<td>146</td>
</tr>
<tr>
<td>12</td>
<td>Exporting Data to an Excel Workbook</td>
<td>147</td>
</tr>
<tr>
<td>12</td>
<td>Exporting Data</td>
<td>147</td>
</tr>
<tr>
<td>12</td>
<td>LESSON 12 - EXPORTING DATA</td>
<td>147</td>
</tr>
</tbody>
</table>
LESSON 1 - USING CHARTS

In this lesson, you will learn how to:

- Work with charts
- Add a chart to a form or report
- Use Microsoft Graph to edit
- Change the chart type
- Change the chart title
- Format the chart title
- Add data labels to a chart
Working with Charts

Discussion

Access allows you to enhance forms and reports by adding graphs, pictures, and other objects. For example, the Chart Wizard assists you in creating charts quickly. Charts allow you to represent information in a database graphically. Charts can be either two or three dimensional, depending on the type and amount of data you need to represent.

Access includes a number of charts from which you can choose. The Chart Wizard provides a description of each chart type to assist you in selecting the appropriate type for the data you are using. For example, a bar chart best represents comparisons of like data, such as quarterly profits, and a pie chart best represents parts of a whole, such as each salesperson’s contribution to overall sales. Many of the available charts are similar in the way they represent data, but differ aesthetically. For instance, you can replace the bars in a bar chart with cylinders or cones to provide a more dramatic effect.

Depending on the type of chart selected, you may have a series field, a data field, and an axis field associated with the chart. After selecting the chart type and advancing the wizard, Access will automatically insert fields into the series, data, and axis boxes from those available. You may change the contents of any of these boxes by dragging the field buttons in and out of the boxes.

![Pie Chart](image)

If the fields you need to create a chart are in different tables, you can create a query to combine the fields and then base the chart on the results of the query.
Procedures

1. Display **All Access Objects** in the Navigation Pane, if necessary.

2. Select the **Form Design** button in the **Forms** group on the **Create** tab.

3. Select the **Insert Chart** button in the **Controls** group on the **Design** tab.

4. Click on the blank form.

5. Select the desired object from the **Which table or query would you like to use to create your chart?** list.

6. Select **Next >**.

7. Add the field containing the data you want to display in the chart from the **Available Fields** list box.

8. Add additional fields from the **Available Fields** list box as desired.

9. Select **Next >**.

10. Select the desired chart type.

11. Select **Next >**.

12. Arrange the contents of the chart as desired.

13. Select **Next >**.

14. Type a title for the chart.

15. Select whether or not to display a legend on the chart.

16. Select **Finish**.

Step-by-Step

From the Student Data directory, open **CHART1.ACCDB**.
Create a chart using the Chart Wizard.

If necessary, display **All Access Objects** in the Navigation Pane.
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Form Design** button in the **Forms** group on the **Create** tab.  
  *A new blank form opens in Design view.* | ![Form Design](image)               |
| 2. Select the **Insert Chart** button in the **Controls** group on the **Design** tab.  
  *The Insert Chart button is selected.* | ![Insert Chart](image)             |
| 3. Click on the blank form.  
  *The Chart Wizard opens.* | ![Click on the blank form](image)  |
| 4. Select the table or query on which you want to base the chart.  
  *The table or query name appears in the Which table or query would you like to use to create your chart? box.* | ![Table: Packing Slip](image)      |
| 5. Select **Next**.  
  *The next page of the Chart Wizard is displayed.* | ![Click Next >](image)             |
| 6. Add the field containing the data you want to display in the chart from the **Available Fields** list box.  
  *The field name appears in the Fields for Chart list box.* | ![Double-click Ord Tot](image)     |
| 7. Add additional fields from the **Available Fields** list box as desired.  
  *The field name(s) appear in the Fields for Chart list box.* | ![Double-click Sales Rep](image)   |
| 8. Select **Next**.  
  *The next page of the Chart Wizard is displayed.* | ![Click Next >](image)             |
| 9. Select the desired chart type.  
  *The chart type is selected and a description of the chart type appears in the right panel of the Chart Wizard.* | ![Click the Pie Chart](image)      |
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 10. Select **Next**.  
*The next page of the Chart Wizard is displayed and the fields are automatically inserted into the Chart preview.* | Click ![Next >](#) |
| 11. Arrange the contents of the chart, if necessary.  
*The next page of the Chart Wizard is displayed with the text in the What title would you like for your chart? box selected.* | Click ![Next >](#) |
| 12. Type a title for the chart.  
*The title appears in the What title would you like for your chart? box.* | Type **Sales by Rep** |
| 13. Select whether or not to display a legend on the chart.  
*The appropriate option is selected.* | Click ![Yes, display a legend.](#), if necessary |
| 14. Select **Finish**.  
*The Chart Wizard closes and the chart is displayed on the form.* | Click ![Finish](#) |

Close the form and save it as **Sales by Rep Chart**.

## Adding a Chart to a Form or Report

### Discussion

Access considers a chart to be an unbound object, meaning that you can manipulate the chart as you would any other object. For example, a chart can be added to a form or report to improve its usefulness and appearance.

A chart appears differently in **Design** view, due to the fact that the actual data is not displayed.
Procedures

1. If necessary, display All Access Objects in the Navigation Pane.
2. Open the desired form or report in Design view.
3. Select the chart object.
4. Right-click the chart object.
5. Select Copy.
6. Close the form or report.
7. Open the desired form or report in Design view.
8. Click in the desired section of the form or report.
9. Click the Paste button in the Clipboard group on the Home tab.

Step-by-Step

Add a chart to a form or report.

If necessary, open the Sales by Rep Chart form in Design view.

If the Sales by Rep Chart form does not exist, open the Sales by Rep Chart 1 form in Design view.

If necessary, display All Access Objects in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the chart object.</td>
<td>Click the Sales by Rep pie chart</td>
</tr>
<tr>
<td><em>Sizing handles appear around the chart object and the mouse pointer changes into a black hand when positioned on the selected chart object.</em></td>
<td></td>
</tr>
<tr>
<td>2. Right-click the chart object.</td>
<td>Right-click the chart object</td>
</tr>
<tr>
<td><em>A shortcut menu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select Copy.</td>
<td>Click Copy</td>
</tr>
<tr>
<td><em>The chart object is copied to the Office Clipboard.</em></td>
<td></td>
</tr>
</tbody>
</table>
Steps | Practice Data
---|---
4. Close the form or report. The form or report closes. | Click <br>Drag the chart down to the 1cm mark on the vertical ruler to display the Sales Data chart title.
5. Open the desired form or report from the Navigation Pane in Design view. The form or report is selected. | Open the Sales Data report in Design view
6. Click in the desired section of the form or report. The desired section is selected. | Click in the Report Header section
7. Click the Paste button in the Clipboard group on the Home tab. The chart object appears in the appropriate section of the form or report. | Click

**USING MICROSOFT GRAPH TO EDIT**

**Discussion**

You may want to make changes to a chart to improve its appearance or emphasize aspects of the chart. You can change the chart type; the text of the chart, such as the title and the data labels; the colors used in the chart; and the actual data the chart displays. When editing a chart, Access displays an editing toolbar to allow you to quickly make changes.

You use Microsoft Graph to modify charts in Access. The Microsoft Graph window consists of two elements. The first element is the datasheet window. The datasheet is a worksheet of the data that is used to create the chart. Any changes to the data comprising the chart are made in the datasheet. The second element is the Chart window, which displays the graphical representation of the data. You can make a chart easier to read by revising its appearance, such as modifying the layout or formatting the title.

It is important to note that a chart is displayed in a control. Microsoft Graph is used to edit the chart and chart data within the control. Formatting changes, such as moving or resizing the chart, are accomplished by manipulating the control in Design view of the form or report.

The datasheet window consists of rows and columns in which you can enter labels and numbers. The rows are identified with numbers and the columns are identified with
letters. The intersection of a row and column identifies the cell with a cell address, such as A1, CA10, DE100, etc. When you make a change in the datasheet window, the changes are reflected in the chart window.

The major parts of the datasheet window are listed in the following table:

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row headings</td>
<td>The identifiers to the left of the first column in the datasheet.</td>
</tr>
<tr>
<td>Column headings</td>
<td>The identifiers above the top row of the datasheet.</td>
</tr>
<tr>
<td>Cell</td>
<td>The intersection of a column and row.</td>
</tr>
<tr>
<td>Data point</td>
<td>A single cell value.</td>
</tr>
<tr>
<td>Data series</td>
<td>A row or column of data.</td>
</tr>
<tr>
<td>Series names</td>
<td>Names used to identify each row or column of data that appear in the legend of the Chart window.</td>
</tr>
</tbody>
</table>

The major parts of the chart window are listed in the following table:

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>The area inside the Chart window.</td>
</tr>
<tr>
<td>Data marker</td>
<td>An item in a chart that marks a single data point or value, such as a bar, shape, or symbol.</td>
</tr>
<tr>
<td>Data series</td>
<td>A group of data points. A chart can have one or more data series.</td>
</tr>
<tr>
<td>Attached text</td>
<td>Describes the data or items in a chart and is linked to a chart item, such as a data marker. Attached text moves with the item to which it is linked, and cannot be moved independently.</td>
</tr>
<tr>
<td>Unattached text</td>
<td>Describes the data or items in a chart. Because it is not linked, you can move unattached text anywhere on a chart.</td>
</tr>
<tr>
<td>Gridlines</td>
<td>Optional lines that make it easier to view the data values.</td>
</tr>
<tr>
<td>Axes</td>
<td>Lines that serve as a major reference point for plotting data in charts. Usually, categories of data are plotted along the horizontal (x) axis and data values are plotted along the vertical (y) axis.</td>
</tr>
</tbody>
</table>
If you need to change the data in the chart datasheet, you may need to move the chart so that you can see the datasheet.

## Procedures

1. Open the desired form or report in **Design** view.
2. Right-click the chart object you want to edit.
3. Point to **Chart Object**.
4. Select **Edit**.

## Step-by-Step

Activate Microsoft Graph to edit a chart.

If you have not been using the **Sales Data** report, open the **Sales Data 1** report in **Design** view.
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Right-click the chart object you want to edit. The shortcut menu is displayed.</td>
<td>Right-click the Sales by Rep pie chart, if necessary</td>
</tr>
<tr>
<td>2. Point to Chart Object. The Chart Object submenu is displayed.</td>
<td>Point to Chart Object</td>
</tr>
<tr>
<td>3. Select Edit. The Microsoft Graph window opens.</td>
<td>Click Edit</td>
</tr>
</tbody>
</table>

The chart can now be edited, as necessary.

### Changing the Chart Type

**Discussion**

After creating a chart, you may decide to display the data more effectively with another type of chart. You can change the chart type in the Microsoft Graph window. Access includes a number of chart types from which you can choose.

You can also choose from a number of available chart sub-types. An example of a chart sub-type is a pie chart that is “exploded”, meaning the wedges of the pie are pulled out from the center.

![The Chart Type dialog box](image)
Because it is very easy to change the chart type and/or sub-type while in the Microsoft Graph window, you may want to sample several types of charts to find the one that best emphasizes your point.

Procedures

1. Open the desired form or report in **Design** view.
2. Open the Microsoft Graph window.
3. Select the **Chart** menu.
4. Select **Chart Type**....
5. Select the **Standard Types** tab, if necessary.
6. Select the desired chart type from the **Chart type** list box.
7. Select the desired chart sub-type.
8. Click and hold the **Press and Hold to View Sample** button.
9. Release the mouse button.
10. Select **OK**.

Step-by-Step

Change the chart type.

If you have not been using the **Sales Data** report, open the **Sales Data 1** report in **Design** view.

If necessary, open the Microsoft Graph window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Chart</strong> menu.</td>
<td>Click <strong>Chart</strong></td>
</tr>
<tr>
<td><em>The Chart menu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select <strong>Chart Type</strong>....</td>
<td>Click <strong>Chart Type</strong></td>
</tr>
<tr>
<td><em>The Chart Type dialog box opens.</em></td>
<td></td>
</tr>
</tbody>
</table>
### CHANGING THE CHART TITLE

**Discussion**

You can change the title of a chart in the Microsoft Graph window. If the data in the chart has changed, you can revise the title to provide a better description of the chart’s contents.

**Procedures**

1. Open the desired form or report in **Design** view.
2. Open the Microsoft Graph window.
3. Select the chart title.
4. Select the chart title text.
5. Type the new title for the chart.
6. Click in a blank area of the chart to deselect the chart title.

Step-by-Step

Change the chart title.

If you have not been using the Sales Data report, open the Sales Data 2 report in Design view.

If necessary, open the Microsoft Graph window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the chart title. <em>Sizing handles appear around the chart title.</em></td>
<td>Click Sales by Rep</td>
</tr>
<tr>
<td>2. Drag to select the word you wish to change in the title text. <em>The word is selected.</em></td>
<td>Double click to select the word Sales</td>
</tr>
<tr>
<td>3. Type the new word for the chart title. <em>The new title appears on the chart.</em></td>
<td>Type Profit</td>
</tr>
<tr>
<td>4. Click in a blank area of the chart to deselect the chart title. <em>The new title is entered into the chart.</em></td>
<td>Click in a blank area of the chart</td>
</tr>
</tbody>
</table>

**FORMATTING THE CHART TITLE**

Discussion

You can format the chart title in the Microsoft Graph window. You can change the pattern, font, and alignment of the chart title. The pattern of the chart title controls the type of border around the title, if any, and the background color of the title. The font controls the appearance of the chart title text, such as font type, style, and size. The
alignment of the chart title controls where the title text appears relative to the chart, as well as the orientation of the title text.

 Procedures

1. Open the desired form or report in Design view.
2. Open the Microsoft Graph window.
3. Select the chart title.
4. Select the Format menu.
5. Select Selected Chart Title....
6. Select the tab for the desired type of formatting changes.
7. Select the desired format.
8. Select OK.

 Step-by-Step

Format the chart title.

If you have not been using the Sales Data report, open the Sales Data 3 report in Design view.

If necessary, open the Microsoft Graph window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the chart title.</td>
<td>Click Profit by Rep</td>
</tr>
<tr>
<td><em>Sizing handles appear around the chart title.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select the Format menu.</td>
<td>Click Format</td>
</tr>
<tr>
<td><em>The Format menu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select Selected Chart Title....</td>
<td>Click Selected Chart Title...</td>
</tr>
<tr>
<td><em>The Format Chart Title dialog box opens.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select the tab for the desired type of formatting changes.</td>
<td>Click the Font tab</td>
</tr>
<tr>
<td><em>The appropriate page appears.</em></td>
<td></td>
</tr>
</tbody>
</table>
Steps

5. Select the desired format.
   The desired format is selected.

6. Select OK.
   The Format Chart Title dialog box closes and the selected format is applied to the chart title.

Practice Data

Scroll the Size list box as necessary and click 12

Click [OK]

Click in a blank area of the chart to deselect the chart title.

Adding Data Labels to a Chart

Discussion

You can add data labels to a chart in the Microsoft Graph window. These labels identify the data displayed in the chart. They differ from the legend in that they are placed on the pieces of the chart, rather than in a key beside it. Data labels can display amounts and percentages from the chart data. You can use data labels to present a more detailed and effective chart.

Procedures

1. Open the desired form or report in Design view.
2. Open the Microsoft Graph window.
3. Select the chart plot area.
4. Select the Chart menu.
5. Select Chart Options....
6. Select the Data Labels tab.
7. Select the desired data labels option.
8. Select [OK]

Step-by-Step

Add data labels to a chart.
If you have not been using the Sales Data report, open the Sales Data 4 report in Design view.

If necessary, open the Microsoft Graph window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the chart plot area. <em>Sizing handles appear around the chart plot area.</em></td>
<td>Click the chart plot area</td>
</tr>
<tr>
<td>2. Select the Chart menu. <em>The Chart menu is displayed.</em></td>
<td>Click Chart</td>
</tr>
<tr>
<td>3. Select Chart Options.... <em>The Chart Options dialog box opens.</em></td>
<td>Click Chart Options…</td>
</tr>
<tr>
<td>4. Select the Data Labels tab. <em>The Data Labels page appears.</em></td>
<td>Click the Data Labels tab</td>
</tr>
<tr>
<td>5. Select the desired data labels option. <em>The desired data labels option is selected and a sample of the choice appears in the sample box on the right in the Chart Options dialog box.</em></td>
<td>Click ☑ Percentage</td>
</tr>
<tr>
<td>6. Select OK. <em>The Chart Options dialog box closes and the data labels appear on the chart.</em></td>
<td>Click OK</td>
</tr>
</tbody>
</table>

Close the Microsoft Graph window. Then close and save the report. Close CHART1.ACCDB.
EXERCISE

USING CHARTS

Task

Use a chart.

1. Open CHART1X.ACCDB.
2. Display All Access Objects in the Navigation Pane.
3. Using the Chart Wizard, select the Sales table, and include the Cost and Sales Rep fields to create a Bar Chart (second row, first column). Accept the default layout and title for the chart and select not to display a legend. Select to open the report with the chart displayed on it.
4. Switch to Design view. View the Sales chart in the Microsoft Graph window. *(Hint: When you display the chart in the Microsoft Graph window, the data that appears is sample data. It is not representative of the actual data that will appear in the final chart.)*
5. Change the chart type to Column. Select the Clustered Column sub-type, if necessary.
6. Change the chart title to Sales Reps.
7. Apply the Bold Italic style and a 12 point font size to the chart title.
8. Add data labels that show the actual values represented by the chart.
9. Size and position the chart as necessary to view the values.
10. Close Microsoft Graph and preview the report.
LESSON 2 -
USING SUBFORMS/SUBREPORTS

In this lesson, you will learn how to:

- Work with subforms/subreports
- Create a subform/subreport
- Edit the layout of a subform
- Display a subform in Datasheet view
- Display a subform/subreport total
WORKING WITH SUBFORMS/SUBREPORTS

Discussion

You can display a form or report within a form or report, which then creates a main form or report and a corresponding subform or subreport. The main form/report includes information from one table and the subform/subreport includes information from a second, related table.

You can show a form/report within a form/report to more effectively show the linked data from tables with one-to-many relationships. The main form/report and the subform/subreport are linked by a common field between the tables. The main form/report represents the one side of the one-to-many relationship and the subform/subreport represents the many side. When viewing a record in the main form/report (one side relationship), the subform/subreport displays the related records from another table (many side relationship). For example, you have a Customer table and an Orders table. Each customer has several orders. In the Customer form (bound to the Customer table), you can include an Orders subform (bound to the Orders table). The tables would most likely be linked by a Customer ID field; a field present in both tables. As you view a customer’s record displayed in the main form, the order records of that customer appear in the subform. When you move to the next customer record in the main form, the order records in the subform are updated to display that customer’s orders. Just as you can manipulate table data in a form, you can also manipulate the related table data using the subform. Using the same example, you can edit the customer records or the order records.

Subform data can be displayed in either Form view (one record at a time) or Datasheet view (many records displayed at once), while subreport data can only be displayed in print preview. You can also create and display subform data in a PivotTable or PivotChart.

You can add any number of subforms/subreports to a form/report as well as add a subform/subreport within another subform/subreport. You should keep in mind that the purpose of a form or report is to make viewing and entering data easier. You can avoid cluttering the form or report, which can cause confusion, by positioning the subform(s) or subreport(s) carefully, assigning a different background color to each, and removing any unnecessary items, such as scroll bars. Viewing the properties of the subform/subreport is helpful when considering these options.

The SubForm/SubReport Wizards provide the easiest method for creating a subform or subreport. If you choose not to use the SubForm/SubReport Wizards, you will need to design a form/report and then insert it into another form/report. You may not want to use the wizard if you are designing a subform/subreport that is very different in appearance from the form or report the wizard produces.
**CREATING A SUBFORM/SUBREPORT**

**Discussion**

When you add a subform/subreport to an existing form, it is best to start by creating the main form/report before you create the subform/subreport. The form/report can then be edited so that it contains only the information you need, as well as the desired layout. This form/report can be added to the design of the main form/report where it will take on the properties of a subform or subreport.

You can create a subform that may be viewed in **Form** view, **Datasheet** view, or both views. You can create a subreport that may be viewed in **Preview** view. You can customize the subform in **Design** view by adding items such as headers, footers, color, fonts, and totals.

The SubForm/SubReport Wizard prompts you for the following information:

1. If you want to use an existing form/report as the subform/subreport or build a new one from tables and queries.
2. If you want to define the link between the main form/report and subform/subreport yourself or choose from a list of available link options.
3. A name for the subform or subreport.

*A subform within a form*
Although it is not necessary to click the Control Wizards button before creating a subform or subreport, it is recommended. Clicking this button enables the control wizards that assist you in creating a subform or subreport.

Procedures

1. Open the desired database.
2. Open the desired form or report in Design view.
3. Select the Design tab on the Ribbon.
4. Click the Control Wizards button in the Controls group, if necessary.
5. Click the Subform/Subreport button in the Controls group.
6. Click in the form or report where you want to place the top left corner of the subform or subreport.
7. Select the desired option for the source of the subform or subreport.
8. Select the desired form or report you want to insert as a subform or subreport.
9. Select.
10. Select the desired link option.
11. Select the desired link for the subform or subreport from the list box.
12. Select.
13. Type a name for the subform or subreport.

Step-by-Step

From the Student Data directory, open SUBFORM.ACCDB.
Create a subform/subreport.
Open the **Order Entry** form in **Design** view.

If necessary, display the ruler, and select the **Design** tab on the **Ribbon**.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Control Wizards</strong> button in the <strong>Controls</strong> group, if necessary. <em>The Control Wizards are enabled.</em></td>
<td>Click [ ] , if necessary</td>
</tr>
<tr>
<td>2. Click the <strong>Subform/Subreport</strong> tool in the <strong>Controls</strong> group. <em>The mouse pointer changes into a plus sign (+) with a form attached when positioned over the form.</em></td>
<td>Click [ ]</td>
</tr>
<tr>
<td>3. Click in the form or report where you want to place the top left corner of the subform or subreport. <em>The default control for the subform or subreport appears and the SubForm or SubReport Wizard opens.</em></td>
<td>Click in the form at the 1.5” mark on the vertical ruler, under the <strong>Shipping Cost</strong> label box</td>
</tr>
<tr>
<td>4. Select the desired option for the source of the subform or subreport. <em>The desired option is selected.</em></td>
<td>Click [ ] <strong>Use an existing form</strong></td>
</tr>
<tr>
<td>5. Select the desired form or report you want to insert as a subform or subreport. <em>The desired form or report is selected.</em></td>
<td>Scroll as necessary and click <strong>Order Items</strong></td>
</tr>
<tr>
<td>6. Select <strong>Next</strong>. <em>The next page of the SubForm or SubReport Wizard is displayed.</em></td>
<td>Click [ ] <strong>Next &gt;</strong></td>
</tr>
<tr>
<td>7. Select the desired link option. <em>The desired link option is selected.</em></td>
<td>Click [ ] <strong>Choose from a list</strong>, if necessary</td>
</tr>
<tr>
<td>8. Select the desired link for the subform or subreport from the list box. <em>The desired link is selected.</em></td>
<td>Click <strong>Show Order Items for each record in Orders using Order Number</strong>, if necessary</td>
</tr>
</tbody>
</table>
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 9. Select **Next**.  
The next page of the SubForm or SubReport Wizard is displayed with the insertion point in the **What name would you like for your subform or subreport?** box. | Click [Next >] |
| 10. Type a name for the subform or subreport.  
The name appears in the **What name would you like for your subform or subreport?** box. | Type **Order Items of Company** |
| 11. Select **Finish**.  
The SubForm or SubReport Wizard closes and the subform or subreport appears in the form or report. | Click [Finish] |

Size the subform control (from the bottom edge and right corner) so that it is approximately 1 1/2" high and 3 1/2" wide, if necessary. Switch to **Form** view to view the subform. Switch back to **Design** view and deselect the subform control, if necessary.

Close and save the form.

**Practice the Concept:** Create a subreport in the **Sales Data 1** report at the 2.5” mark on the horizontal ruler and the 1” mark on the vertical ruler. Use the **Qtr 2 Sales** report for the subreport and select the first **Show Customer Sales Query for each record in Customer Sales Query** option for the link. Accept the default name for the subreport and view the report in print preview.

Close and save the report.

---

### EDITING THE LAYOUT OF A SUBFORM

**Discussion**

In order to improve the efficiency or appearance of a subform/subreport, you can change its layout the same way you would change the layout of a form/report. In **Design** view for the main form/report, the subform/subreport is a control that you can move, resize, align, add, and delete as you would any other control. Since the subform/subreport control contains a form/report, you can open it in **Design** view and make any editing changes to its controls. Any changes to the layout of the subform/subreport are performed in **Design** view.
You can open a subform/subreport into a separate Design window by right-clicking the desired subform/subreport and then selecting Subform in New Window or Subreport in New Window from the shortcut menu.

Procedures

1. Open the main form in Design view.
2. Double-click the subform control you want to edit.
3. Double-click the subform control text to select it.
4. Make the desired editing changes.

Step-by-Step

Edit the layout of a subform.

Open the Order Entry form in Design view.

If you have not been using the Order Entry form, open the Order Entry 1 form in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Double-click the subform control you want to edit. <em>The subform control is selected and the property sheet for the control opens.</em></td>
<td>Scroll as necessary and double-click the subform Qty unbound control (the Qty label box in the subform)</td>
</tr>
<tr>
<td>2. Double-click the subform control text to select it. <em>The text is selected.</em></td>
<td>Double-click the text Qty in the label box</td>
</tr>
<tr>
<td>3. Make the desired editing changes. <em>The editing changes are made.</em></td>
<td>Type <em>Quantity</em></td>
</tr>
<tr>
<td>4. Continue making editing changes as desired. <em>The editing changes are made.</em></td>
<td>Press [Enter]</td>
</tr>
</tbody>
</table>
Close the property sheet, then save and close the form.

**DISPLAYING A SUBFORM IN DATASHEET VIEW**

**Discussion**

You can display a subform in **Datasheet** view. This option allows you to view many subform records at once, rather than viewing them one at a time in **Form** view. Since the benefit of using subforms is to display the “many” side of a one-to-many relationship, **Datasheet** view is generally preferred.

![A subform in Datasheet view](image)

**Procedures**

1. Open the main form in **Form** view.
2. Select a field in the subform.
3. Select the **View** button in the **Views** group on the **Design** tab.
4. Select **Datasheet** view.
5. Click the plus sign + at the beginning of a record to view the subform data for that record.
Step-by-Step

Display a subform in **Datasheet** view.

If you have not been using the **Order Entry** form, open the **Order Entry 2** form in **Form** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select a field in the subform.</td>
<td>Click in the <strong>Product ID</strong> field</td>
</tr>
<tr>
<td><em>The insertion point appears in the selected field and the subform becomes active.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select the <strong>View</strong> button in the <strong>Views</strong> group on the <strong>Home tab</strong>.</td>
<td>Click <strong>View</strong> button</td>
</tr>
<tr>
<td><em>The View menu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select <strong>Datasheet</strong> view.</td>
<td>Click <strong>Datasheet</strong> view</td>
</tr>
<tr>
<td><em>The form is displayed in <strong>Datasheet</strong> view.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select the plus sign next to the desired record(s).</td>
<td>Click + for record 3</td>
</tr>
<tr>
<td><em>The subform data for the desired record is displayed.</em></td>
<td></td>
</tr>
</tbody>
</table>

Close the form.

**DISPLAYING A SUBFORM/SUBREPORT TOTAL**

Discussion

Forms and reports often include totals of the information they contain. These totals are easily created by adding a calculated control to the form or report that contains an expression to find the desired total. Expressions are used to obtain information you cannot obtain directly from the tables in your database. For example, if you have a table that contains the quantity and cost of various items, you could use an expression to multiply the quantity and the cost to obtain the current inventory value. Every time you use a form/report, Access calculates any expressions contained in the form/report, helping you keep your information as accurate as possible.

Some examples of expressions are listed in the following table:
You may want to include a total of information, contained in a subform/subreport, in the main form/report total. For example, an Orders form may contain a control for shipping charges. The information in the Product subform may include a total, such as the total cost of all the products ordered. You can display this subform total on the main form so that you can add the shipping charges to this total to create a grand total. This option is performed by adding a control to the main form/report, which refers to the desired subform/subreport total control, to display the information.

The expression in the main form/report control that refers to the subform/subreport control defines the name of the subform/subreport and the name of the subform/subreport control being used in the following format:

\[ = \text{[Name of the Subform/Subreport]}!\text{[Name of the Subform/Subreport Control]} \]

You can also display a subreport total in the main report using the same methods that you use to display a subform total.

Procedures

1. Open the form or report in Design view.

2. Select the Text Box button in the Controls group on the Design tab.
3. Click in the form or report where you want to insert the control.

4. Select the label box.

5. Select the text in the label box.

6. Type a label in the label box.

7. Select the text box.


9. Select the Data tab.

10. Type the expression that refers to the desired subform/subreport control.


Step-by-Step

Display a subform/subreport total in the main form/report.

Open the Product List form in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the Text Box tool in the Controls group on the Design tab. &lt;br&gt;The mouse pointer changes into a text box with a plus sign (+) when positioned over the form.</td>
<td>![Text Box] Click</td>
</tr>
<tr>
<td>2. Click in the form or report where you want to insert the control. &lt;br&gt;The control appears on the form or report.</td>
<td>Scroll as necessary and click in the form below the subform, in line with the 3.5” mark on the horizontal ruler</td>
</tr>
<tr>
<td>3. Select the label box. &lt;br&gt;Sizing handles appear around the label box.</td>
<td>Click in the label box</td>
</tr>
<tr>
<td>4. Drag to select the text in the label box. &lt;br&gt;The text is selected.</td>
<td>Drag to select Textxx: (xx is a number)</td>
</tr>
<tr>
<td>5. Type a label in the label box. &lt;br&gt;The label appears in the label box.</td>
<td>Type Items Total</td>
</tr>
<tr>
<td>Steps</td>
<td>Practice Data</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>6. Select the text box.</td>
<td>Click in the text box</td>
</tr>
<tr>
<td>Sizing handles appear around the text box.</td>
<td></td>
</tr>
<tr>
<td>7. Press [F4] to open the property sheet.</td>
<td>Press [F4], if necessary</td>
</tr>
<tr>
<td>The property sheet for the selected text box opens.</td>
<td></td>
</tr>
<tr>
<td>8. Select the <strong>Data</strong> tab.</td>
<td>Click the <strong>Data</strong> tab, if necessary</td>
</tr>
<tr>
<td>The <strong>Data</strong> page appears with the insertion point in the <strong>Control</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Source</strong> property.</td>
<td></td>
</tr>
<tr>
<td>9. Type the expression that refers to the desired subform/subreport</td>
<td>Type <code>=[Order Items of Company]![Total]</code></td>
</tr>
<tr>
<td>control.</td>
<td></td>
</tr>
<tr>
<td>The expression appears in the <strong>Control Source</strong> property.</td>
<td></td>
</tr>
<tr>
<td>The property sheet closes and the expression replaces the text in the</td>
<td></td>
</tr>
<tr>
<td>text box.</td>
<td></td>
</tr>
</tbody>
</table>

View the form in **Form** view. Scroll to view the **Items Total** field, if necessary. Then, close and save the form.
Close **SUBFORM.ACCDB**.
EXERCISE

USING SUBFORMS/SUBREPORTS

Task

Use a subform/subreport.

1. Open SUBFORMX.ACCDB.
2. Open the Invoice Form form in Design view.
3. Use the SubForm Wizard to create a subform in the bottom center of the form.
4. Insert the existing Project Form form as a subform.
5. Select the appropriate option from the list box to link the main form and subform by the Project ID field. Name the subform Project Info.
6. Delete the subform’s label box.
7. Size and position the subform control so that all the fields appear, if necessary.
8. Switch to Form view to see the subform.
9. Select the Project ID field in the subform and switch to Datasheet view.
10. Close and save the form.
11. Open the Payment Form form in Design view.
12. Create a total for the subform called Early bird discount in the Payment Form form at the 5” mark on the horizontal ruler below the subform. Use 15% as the discount.
13. View the form in Form view to see the subform total.
14. Close the form without saving the changes.
15. Close the database file.
LESSON 3 -
USING OTHER FORM TECHNIQUES

In this lesson, you will learn how to:

- Create a split form
- Convert an existing form to a split form
- Edit a split form
- Add a command button
- Save a form as a report
CREATING A SPLIT FORM

Discussion

A split form is a new feature that allows you to create a form that combines the Datasheet view and the Form view, providing you with two different views of your data simultaneously. You can use the Datasheet section to quickly locate records, and the Form section to view and edit them as required. Selecting a field in one part of the form selects the same field in the other part. You can add, delete and edit the data in either part of the form.

Procedures

1. Open the desired table in Datasheet view.
2. Select the Create tab on the Ribbon, if necessary.
3. Select the Split Form button in the Forms group.
Step-by-Step

From the Student Data directory, open FORMTEC.ACCDB.
Create a split form.

Open the Items table in Datasheet view, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Create tab on the Ribbon, if necessary. The Create tab is displayed.</td>
<td>Click Create</td>
</tr>
<tr>
<td>2. Select the Split Form button in the Forms group. The new split form appears in the application window.</td>
<td>Click Split Form</td>
</tr>
</tbody>
</table>

Save the form with the default form name Items, and close it.

CONVERTING AN EXISTING FORM TO A SPLIT FORM

Discussion

You can convert an existing form into a split form by changing your form properties. This will enable you to view your form in two different views simultaneously.

Procedures

1. Open the desired form in Design view.
3. Select Form from the dropdown list at the top of the property sheet.
4. Select the Format tab on the property sheet, if necessary.
5. Select Split form from the drop-down list next to Default view.
6. Select Form View in the Views group on the Home tab.
Step-by-Step

Convert an existing form into a split form.

Open the Customer Data Entry form in Design view, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Press [F4] to display the property sheet. The property sheet is displayed.</td>
<td>Press [F4], if necessary</td>
</tr>
<tr>
<td>2. Select Form from the selection type dropdown list at the top of the property sheet, if necessary. The form option is selected.</td>
<td>Select Form</td>
</tr>
<tr>
<td>3. Select the Format tab on the property sheet, if necessary. The Format tab is displayed.</td>
<td>Click Format tab</td>
</tr>
<tr>
<td>4. Select Split Form from the drop-down list next to Default view. Access converts the form to a split form.</td>
<td>Select Split Form</td>
</tr>
<tr>
<td>5. Select Form View in the Views group on the Home tab. The view changes to Form view.</td>
<td>Select Form View</td>
</tr>
</tbody>
</table>

EDITING A SPLIT FORM

Discussion

After you have created a split form, you can edit it using the property sheet. To improve the appearance of your form, you can change the control properties, such as font color and size, alignment, fill color and border.
The property sheet

Procedures

1. Open the desired form.
3. Select the desired control from the dropdown list at the top of the property sheet.
4. Select the desired tab on the property sheet, if necessary.
5. Amend the desired field.
6. Press [Enter].

Step-by-Step

Edit a split form.

Open the Customer Data Entry form in Design view, if necessary.
Steps | Practice Data
--- | ---
The property sheet is displayed. | Press [F4], if necessary
2. Select the desired control from the dropdown list at the top of the property sheet. The desired control is selected. | Click Form Header
3. Select the desired tab on the property sheet, if necessary. The desired tab is displayed. | Click Format
4. Change the desired control format. The desired control format is changed. | In header height field type 1” and press [Enter]

When you have finished editing your form, close the property sheet and save.

**ADDING A COMMAND BUTTON**

**Discussion**

You can design one or more command buttons to appear on a form. These command buttons can then be used to access commonly used functions.

Command buttons are particularly useful because they do not require the database user to know the Microsoft Access menu structure. For example, instead of making the user select Print from the Office menu to print a displayed form, you could add the Print function to a command button on the form.

Access provides different actions for you to use, which are available in the following categories: Record Navigation, Record Operations, Form Operations, Report Operations, Application, and Miscellaneous.
If you click the Control Wizards button before you create a command button, Access provides you with a wizard that helps you create the command button.

Procedures

1. Open the desired form in Design view.
2. Click the Control Wizards button in the Controls group on the Design tab.
3. Click the Button button in the Controls group on the Design tab.
4. Click in the form where you want to insert the command button.
5. Select the desired category from the Categories list box.
6. Select the desired action from the Actions list box.
7. Select Next >.
8. Select whether you want text or a picture to display on the button.
9. Select the text in the Text box or select the desired picture.
10. Type the text you want to appear on the button, as necessary.

11. Select Next >.

12. Type the desired name for the button.


---

**Step-by-Step**

Add a command button to a form.

Open the **Order Distribution Form** form in **Design** view.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
</table>
| 1. Click the **Control Wizards** button in the **Controls** group in the **Design** tab.  
*The control wizards are enabled.* | Click ✪, if necessary                                  |
| 2. Click the **Button** button in the **Controls** group in the **Design** tab.  
*The mouse pointer changes into a copy of the tool with a plus sign (+) when positioned over the form.* | Click Button                                             |
| 3. Click in the form where you want to insert the command button.  
*The default control for the form appears and the Command Button Wizard opens.* | Click in the center of the form, beneath the Unit Price control |
| 4. Select the desired category from the **Categories** list box.  
*The desired category is selected and a preview appears in the Sample box.* | Click Record Navigation                               |
| 5. Select the desired action from the **Actions** list box.  
*The desired action is selected and a preview appears in the Sample box.* | Click Go To Next Record                               |
| 6. Select Next.  
*The next page of the Command Button Wizard is displayed* | Click Next >                                            |
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>7. Select whether you want text or a picture to display on the button.</td>
<td>Click 🎨 Text, if necessary</td>
</tr>
<tr>
<td>The appropriate option is selected and appears in the Sample box.</td>
<td></td>
</tr>
<tr>
<td>8. Drag to select the text in the Text box or select the desired picture.</td>
<td>Drag to select the text Next Record</td>
</tr>
<tr>
<td>The text or the picture is selected.</td>
<td></td>
</tr>
<tr>
<td>9. Type the text you want to appear on the button, as necessary.</td>
<td>Type Next</td>
</tr>
<tr>
<td>The text appears in the Text box and in the Sample box.</td>
<td></td>
</tr>
<tr>
<td>10. Select <strong>Next</strong>.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>The next page of the Command Button Wizard appears with the insertion point in the What do you want to name the button? box.</td>
<td></td>
</tr>
<tr>
<td>11. Type the desired name for the button.</td>
<td>Type Next</td>
</tr>
<tr>
<td>The name appears in the What do you want to name the button? box.</td>
<td></td>
</tr>
<tr>
<td>12. Select <strong>Finish</strong>.</td>
<td>Click Finish</td>
</tr>
<tr>
<td>The Command Button Wizard closes and the command button appears on the form.</td>
<td></td>
</tr>
</tbody>
</table>

Switch to **Form** view and click the **Next** button. Notice that next record is displayed. Close the form without saving the changes.

### SAVING A FORM AS A REPORT

#### Discussion

If you have an existing form you print often, you can save the form as a report. It is possible to print a form directly, but reports are more suitable for presenting information on paper, especially if you need to include group totals. Once a form is saved as a report, its structure can be modified in **Report Design** view to suit your needs.
Procedures

1. Display **All Access Objects** in the Navigation Pane, if necessary.

2. Click the form you want to save as a report.

3. Select the **Office** button.

4. Select **Save As**.

5. Type a name for the report.

6. Select the **As** list.

7. Select the desired **Report** or **Form** item.

8. Select **OK**.

Step-by-Step

Save a form as a report.

If necessary, display **All Access Objects** in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Click the form you want to save as a report.  
* A form is selected. | Click Customer Data Entry |
| 2. Select the **Office** button.  
* The **Office** menu opens. | Click |
| 3. Select **Save As**.  
* The Save As dialog box opens with the text in the **Save Form `<form name>`** To box selected. | Click **Save As** |
| 4. Type a name for the report.  
* The name appears in the **Save Form `<form name>`** To box. | Type **Customer Listing** |
| 5. Select the **As** list.  
* The **As** list is displayed. | Click **As** |
<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>6.</strong> Select the desired <strong>Report</strong> or <strong>Form</strong> item.</td>
<td>Click <strong>Report</strong></td>
</tr>
<tr>
<td><em>The Report or Form item appears in the As box.</em></td>
<td></td>
</tr>
<tr>
<td><strong>7.</strong> Select <strong>OK</strong>.</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td><em>The Save As dialog box closes and Access saves the form as a report.</em></td>
<td></td>
</tr>
</tbody>
</table>

Open the **Customer Listing** report to view it. Close the report. Close **FORMTEC.ACCDB**.
EXERCISE

USING OTHER FORM TECHNIQUES

Task

Use other form techniques.

1. Open **FORMTECX.ACCDB**
2. Display All Access Objects in the Navigation Pane, if necessary.
3. Open the **Sales** form and convert it to a split form.
4. Change the font size of the Form Header title to 24 points.
5. Close the **Sales** form, without saving.
6. Open the **Payment Form** in **Design** view. Use the Command Button Wizard to add a command button to go to the last record in the form. *(Hint: Select the Record Navigation category in the wizard and the Go To Last Record action.)* Have the Go To Last picture appear on the command button and name the button **LastRec**. Position the command button on the form, as desired.
7. Switch to **Form** view and click the **LastRec** command button to go to the last record. Close and save the form.
8. Save the **Payment Form** as a report. Use the default Copy of Payment Form as the name of the report.
LESSON 4 -
USING PIVOTTABLES AND PIVOTCHARTS

In this lesson, you will learn how to:

- Create a PivotTable view
- Create a PivotChart view
CREATING A PIVOT TABLE VIEW

Discussion

You can view any database form in PivotTable view. In PivotTable view, you can summarize and analyze large amounts of data. You design a PivotTable view by dragging fields from the Field List to preset drop areas in the PivotTable view workspace. As an alternative to dragging fields, you can also select the desired field in the Field List, select the desired drop area from the bottom of the Field List, and then use the Add to button to add the field to the selected field.

In the Field List, fields are listed below a corresponding fieldset. When you expand the fieldset, the individual fields are displayed. Field names become bold when they are added to the view workspace.

Once the table or chart is designed, fields can be moved, added, or deleted as desired. In addition, you can apply formatting to the items in PivotTable view to enhance its appearance.

When you create a PivotTable view, Access automatically creates a PivotChart view, and vice versa. The PivotTable layout is slightly different than the PivotChart layout, however, and may require slight modification. Specifically, when you drag a field into the Drop Totals or Detail Fields Here area in a PivotTable, that field is added as a detail field which displays the detail but not a summary of the detail. Because of the nature of this field, the information will not display on the chart in the data field area. In this instance, you will need to add that same field to the data area in PivotChart view. The addition is also reflected in the PivotTable. Any formatting applied to items in each view, however, is independent of the other view.

PivotTable views are automatically saved and updated as part of the layout of the form when you close the form.
You can also display data in a table or query in **PivotTable** view.

Changes made in **PivotTable** or **PivotChart** view cannot be undone.

**Procedures**

1. Open the desired form.

2. Click the arrow on the **View** button in the **Views** group on the **Design** tab.

3. Select **PivotTable View**.

4. Click the **Field List** button in the **Show/Hide** group on the **Design** tab, if necessary.

5. To add a row or category, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Row Fields Here** area on the view workspace.
6. Drag the desired field button from the **Field List** to the **Drop Row Fields Here** area.

7. To add a column or series, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Column Fields Here** area on the view workspace.

8. Drag the desired field button from the **Field List** to the **Drop Column Fields Here** area.

9. To add a totals or a data detail field, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Totals or Detail Fields Here** area on the view workspace.

10. Drag the desired field button from the **Field List** to the **Drop Totals or Detail Fields Here** area.

11. To add a filter field, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Filter Fields Here** area on the view workspace.

12. Drag the desired field button from the **Field List** to the **Drop Filter Fields Here** area.

---

### Step-by-Step

From the Student Data directory, open PIVOTS1.ACCDB. Create a PivotTable view.

Open the **Customer Sales Information** form in **Design** View.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the arrow on the <strong>View</strong> button in the <strong>Views</strong> group on the <strong>Design</strong> tab. <em>The View menu is displayed.</em></td>
<td><img src="View.png" alt="View" /> Click</td>
</tr>
<tr>
<td>2. Select <strong>PivotTable View</strong>. <em>The form is displayed in the appropriate view.</em></td>
<td>![PivotTable View](PivotTable View.png)</td>
</tr>
<tr>
<td>3. Click the <strong>Field List</strong> button in the <strong>Show/Hide</strong> group on the <strong>Design</strong> tab, if necessary. <em>The Field List is displayed.</em></td>
<td>![Field List](Field List.png) Click, if necessary</td>
</tr>
<tr>
<td>Steps</td>
<td>Practice Data</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>4. To add a row or category, expand the fieldset on the <strong>Field List</strong> containing the field you want to drag to the <strong>Drop Row Fields Here</strong> area on the view workspace. The fieldset expands.</td>
<td>Click <strong>Store Name</strong></td>
</tr>
<tr>
<td>5. Drag the desired field button from the <strong>Field List</strong> to the <strong>Drop Row Fields Here</strong> area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the <strong>Field List</strong>.</td>
<td>Drag the <strong>Store Name</strong> field to the <strong>Drop Row Fields Here</strong> area</td>
</tr>
<tr>
<td>6. To add a column or series, expand the fieldset on the <strong>Field List</strong> containing the field you want to drag to the <strong>Drop Column Fields Here</strong> area on the view workspace. The fieldset expands.</td>
<td>Click <strong>Customer Type</strong></td>
</tr>
<tr>
<td>7. Drag the desired field button from the <strong>Field List</strong> to the <strong>Drop Column Fields Here</strong> area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the <strong>Field List</strong>.</td>
<td>Drag the <strong>Customer Type</strong> field to the <strong>Drop Column Fields Here</strong> area</td>
</tr>
<tr>
<td>8. To add a totals or a data detail field, expand the fieldset on the <strong>Field List</strong> containing the field you want to drag to the <strong>Drop Totals or Detail Fields Here</strong> area on the view workspace. The fieldset expands.</td>
<td>Click <strong>Credit Limit</strong></td>
</tr>
<tr>
<td>9. Drag the desired field button from the <strong>Field List</strong> to the <strong>Drop Totals or Detail Fields Here</strong> area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the <strong>Field List</strong>.</td>
<td>Drag the <strong>Credit Limit</strong> field to the <strong>Drop Totals or Detail Fields Here</strong> area</td>
</tr>
</tbody>
</table>
Steps |
--- |
10. To add a filter field, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Filter Fields Here** area on the view workspace. The fieldset expands. |
| Practice Data |
| Click **Country** |

11. Drag the desired field button from the **Field List** to the **Drop Filter Fields Here** area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the **Field List**. |
| Drag the **Country** field to the **Drop Filter Fields Here** area |

Close the form, do not save the changes if asked.

**CREATING A PIVOTCHART VIEW**

**Discussion**

You can view any database form in **PivotChart** view.

**PivotChart** view allows you to display data in a graphical environment. You design a PivotChart in the same way you would design a PivotTable, by dragging fields from the **Field List** to preset drop areas in the **PivotChart** view workspace. As an alternative to dragging fields, you can also select the desired field in the **Field List**, select the desired drop area from the bottom of the **Field List**, and then use the **Add to** button to add the field to the selected field.

In the **Field List**, fields are listed below a corresponding fieldset. When you expand the fieldset, the individual fields are displayed. Field names become bolded when they are added to the view workspace.

When you create a **PivotTable** view, Access automatically creates a **PivotChart** view, and vice versa. The PivotTable layout is slightly different than the PivotChart layout, however, and may require slight modification. Specifically, when you drag a field into the **Drop Totals or Detail Fields Here** area in a PivotTable, that field is added as a detail field which displays the detail but not a summary of the detail. Because of the nature of this field, the information will not display on the chart in the data field area. In this instance, you will need to add that same field to the data area in **PivotChart** view. The addition is also reflected in the PivotTable. Any formatting applied to items in each view, however, is independent of the other view.

**PivotChart** views are automatically saved and updated as part of the layout of the form when you close the form.
You can also display data in a table or query in **PivotChart** view.

Changes made in **PivotTable** or **PivotChart** view cannot be undone.

**Procedures**

1. Open the desired form in **Design** view.

2. Click the arrow on the **View** button in the **Views** group on the **Design** tab.

3. Select .

4. Select the **Field List** button on the **Design** tab, if necessary.

5. To add a row or category, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Category Fields Here** area on the view workspace.

6. Drag the desired field button from the **Field List** to the **Drop Category Fields Here** area.

7. To add a column or series, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Series Fields Here** area on the view workspace.

8. Drag the desired field button from the **Field List** to the **Drop Series Fields Here** area.

9. To add a totals or a data detail field, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Data Fields Here** area on the view workspace.

10. Drag the desired field button from the **Field List** to the **Drop Data Fields Here** area.

11. To add a filter field, expand the fieldset on the **Field List** containing the field you want to drag to the **Drop Filter Fields Here** area on the view workspace.

12. Drag the desired field button from the **Field List** to the **Drop Filter Fields Here** area.
Step-by-Step

Create a PivotChart view.

Open the Customer Sales Information 2 form in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the arrow on the View button in the Views group on the Design tab. The View menu is displayed.</td>
<td>Click View</td>
</tr>
<tr>
<td>2. Select PivotChart View. The form appears in the appropriate view.</td>
<td>Click PivotChart View</td>
</tr>
<tr>
<td>3. Display the Field List, if necessary. The Field List is displayed.</td>
<td>Click Field List, if necessary</td>
</tr>
<tr>
<td>4. To add a row or category, expand the fieldset on the Field List containing the field you want to drag to the Drop Category Fields Here area on the view workspace. The fieldset expands.</td>
<td>Click Store Name</td>
</tr>
<tr>
<td>5. Drag the desired field button from the Field List to the Drop Category Fields Here area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the Field List.</td>
<td>Drag the Store Name field to the Drop Category Fields Here area</td>
</tr>
<tr>
<td>6. To add a column or series, expand the fieldset on the Field List containing the field you want to drag to the Drop Series Fields Here area on the view workspace. The fieldset expands.</td>
<td>Click Customer Type</td>
</tr>
</tbody>
</table>
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>7. Drag the desired field button from the Field List to the Drop Series Fields Here area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the Field List.</td>
<td>Drag the Customer Type field to the Drop Series Fields Here area</td>
</tr>
<tr>
<td>8. To add a totals or a data detail field, expand the fieldset on the Field List containing the field you want to drag to the Drop Data Fields Here area on the view workspace. The fieldset expands.</td>
<td>Click Credit Limit</td>
</tr>
<tr>
<td>9. Drag the desired field button from the Field List to the Drop Data Fields Here area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the Field List.</td>
<td>Drag the Credit Limit field to the Drop Data Fields Here area</td>
</tr>
<tr>
<td>10. To add a filter field, expand the fieldset on the Field List containing the field you want to drag to the Drop Filter Fields Here area on the view workspace. The fieldset expands.</td>
<td>Click Country</td>
</tr>
<tr>
<td>11. Drag the desired field button from the Field List to the Drop Filter Fields Here area. A small box appears as you drag, the field appears on the view workspace, and the field name appears bolded in the Field List.</td>
<td>Drag the Country field to the Drop Filter Fields Here area</td>
</tr>
</tbody>
</table>

Close PIVOTS1.ACCDB.
EXERCISE

USING PIVOT TABLES AND PIVOT CHARTS

Task

Use PivotTables and PivotCharts.

1. Open PIVOTS1X.ACCDB.

2. Open the Payment Form in PivotTable view. Design a PivotTable view using Project ID in the row field, Months in the column field (Hint: Select Months under the Payment Date: By Month fieldset), Amount Paid in the detail field, and Credit Rating in the filter field.

3. Bold the Months column headings and change the background of the Project ID row headings to any shade of blue. Close the form without saving the changes.

LESSON 5 - WORKING WITH INDEXES

In this lesson, you will learn how to:

- View indexes
- Create a single field index
- Create a multiple field index
- Delete an index
- Create a multiple field primary key
VIEWING INDEXES

Discussion

You can use indexes to help Access perform quicker sorts and searches. You should index the fields you use regularly to sort or search for data.

Indexes have important properties that are listed in the following table:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary</td>
<td>Designates whether or not the index is the primary key for the table. In other words, this property designates whether or not the data in the indexed field will be used to uniquely identify each record. If this property is set to Yes, the Unique property must be set to Yes.</td>
</tr>
<tr>
<td>Unique</td>
<td>Designates whether or not the values in the indexed field must be unique for each record. You can set this property to Yes without setting the Primary property to Yes.</td>
</tr>
<tr>
<td>Ignore Nulls</td>
<td>Determines whether or not records with null values in the indexed field are included in the index. The default setting is No, which means that null values are included.</td>
</tr>
</tbody>
</table>

You cannot create an index for Memo, OLE, or Hyperlink fields.
If there are a limited number of different values in a field, then indexing the field does not noticeably speed up searches and sorts. In fact, it may slow down data entry and editing.

Procedures

1. Open the desired table in Design view.

2. Click the Indexes button in the Show/Hide group on the Design tab.

Step-by-Step

From the Student Data directory, open INDEX1.ACCDB. View indexes for a table.

Open the Customers table in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Indexes button in the Show/Hide group on the Design tab. The Indexes window opens.</td>
<td>Click Indexes</td>
</tr>
</tbody>
</table>

Close the Indexes window and the Customers table.

CREATING A SINGLE FIELD INDEX

Discussion

You should index at least one field for each table to maximize performance. You should select a field you are likely to use in searches and sorts.

When you change the Indexed property of a field to Yes, you can choose whether or not to allow duplicates. If you choose the No Duplicates option, Access will not allow duplicate values to be entered into the field.
Procedures

1. Open the desired table in **Design** view.
2. Select the field you want to index.
3. Select the **Indexed** property.
4. Select the **Indexed** list.
5. Select the desired indexing option.

Step-by-Step

Create a single field index.

Open the **Orders** table in **Design** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the field you want to index.  
  *The record selector appears to the left of the field name.* | Click the **Order Number** field, if necessary |
| 2. Select the **Indexed** field property.  
  *The insertion point appears in the **Indexed** property and an arrow appears to the right of the property.* | Click in the **Indexed** field property |
| 3. Select the **Indexed** list.  
  *A list of indexing options is displayed.* | Click **Indexed** |
| 4. Select the desired indexing option.  
  *The desired indexing option appears in the **Indexed** property.* | Click **Yes (Duplicates OK)** |

Save the changes to the design of the table and view the table in **Datasheet** view. Notice that the records are sorted in ascending order by the **Order Number** field. Switch back to **Design** view.
CREATING A MULTIPLE FIELD INDEX

Discussion

If you often search on a combination of fields, you can create an index on multiple fields to speed up the searches and sorts. For example, if you want to sort customers in order by region and alphabetically within each region, you can create an index on the Region and Customer fields.

You must create a multiple field index in the Indexes window. All the fields you want to include in the index should be listed under the same index name. You can include up to ten fields in an index.

Procedures

1. Open the desired table in Design view.

2. Click the Indexes button in the Show/Hide group on the Design tab.

3. Select the first blank field in the Index Name column.

4. Type the name of the index.

5. Press [Tab].

6. Select the Field Name list.

7. Select the field you want to index.

8. Press [Tab].

9. Select the Sort Order list.

10. Select the desired sort order.

11. Select the next blank field in the Field Name column.

12. Select the Field Name list.

13. Select the field you want to index.

14. Press [Tab].

15. Select the Sort Order list.

16. Select the desired sort order.

17. Close the Indexes window.
Step-by-Step

Create a multiple field index.

If necessary, open the **Orders** table in **Design** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Indexes</strong> button in the <strong>Show/Hide</strong> group on the <strong>Design</strong> tab. &lt;br&gt; <em>The Indexes window opens.</em></td>
<td>Click <strong>Indexes</strong></td>
</tr>
<tr>
<td>2. Select the first blank field in the <strong>Index Name</strong> column. &lt;br&gt; <em>The insertion point appears in the first blank field in the <strong>Index Name</strong> column.</em></td>
<td>Click the first blank field in the <strong>Index Name</strong> column</td>
</tr>
<tr>
<td>3. Type the name of the index. &lt;br&gt; <em>The name appears in the <strong>Index Name</strong> column.</em></td>
<td>Type <strong>Orders by Customer</strong></td>
</tr>
<tr>
<td>4. Press [Tab]. &lt;br&gt; <em>The insertion point appears in the <strong>Field Name</strong> column and an arrow appears to the right of the field.</em></td>
<td>Press [Tab]</td>
</tr>
<tr>
<td>5. Select the <strong>Field Name</strong> list. &lt;br&gt; <em>A list of the field names in the table is displayed.</em></td>
<td>Click <strong>Field Name</strong></td>
</tr>
<tr>
<td>6. Select the field you want to index. &lt;br&gt; <em>The field name appears in the <strong>Field Name</strong> column.</em></td>
<td>Click the <strong>Customer ID</strong> field</td>
</tr>
<tr>
<td>7. Press [Tab]. &lt;br&gt; <em>The insertion point appears in the <strong>Sort Order</strong> column and an arrow appears to the right of the field.</em></td>
<td>Press [Tab]</td>
</tr>
<tr>
<td>8. Select the <strong>Sort Order</strong> list. &lt;br&gt; <em>A list of sort orders is displayed.</em></td>
<td>Click <strong>Sort Order</strong></td>
</tr>
<tr>
<td>9. Select the desired sort order. &lt;br&gt; <em>The desired sort order appears in the <strong>Sort Order</strong> column.</em></td>
<td>Click <strong>Ascending</strong></td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
10. Select the next blank field in the **Field Name** column.  
The insertion point appears in the **Field Name** column and an arrow appears to the right of the field. | Click the next blank field in the **Field Name** column below the **Customer ID** entry

11. Select the **Field Name** list.  
A list of the field names in the table is displayed. | Click **Field Name**

12. Select the field you want to index.  
The field name appears in the **Field Name** column. | Click the **Order Number** field

13. Press [Tab].  
The insertion point appears in the **Sort Order** column and an arrow appears to the right of the field. | Press [Tab]

14. Select the **Sort Order** list.  
A list of sort orders is displayed. | Click **Sort Order**

15. Select the desired sort order.  
The desired sort order appears in the **Sort Order** column. | Click **Ascending**

---

Close the Indexes window. Close the table without saving the changes.

**DELETING AN INDEX**

**Discussion**

Indexes take up disk space and can slow down the process of adding, editing, and deleting records. In fact, if there are a limited number of different values in a field, the sort or search speed is not significantly increased by indexing the field. Therefore, you can delete any unwanted indexes to increase efficiency.

**Procedures**

1. Open the desired table in **Design** view.
2. Click the **Indexes** button in the **Show/Hide** group on the **Design** tab.

3. Point to the row selector to the left of the row containing the index you want to delete.

4. Click the row selector to the left of the row containing the index you want to delete.

5. Press **[Delete]**.

---

### Step-by-Step

Delete an index.

Open the **Packing Slip** table in **Design** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Indexes</strong> button in the <strong>Show/Hide</strong> group on the <strong>Design</strong> tab. <em>The Indexes window opens.</em></td>
<td>![Click Indexes]</td>
</tr>
<tr>
<td>2. Point to the row selector to the left of the row containing the index you want to delete. <em>The mouse pointer changes into a black, horizontal arrow pointing to the right.</em></td>
<td>Point to the row selector to the left of the <strong>Prod ID</strong> field in the <strong>Index Name</strong> column</td>
</tr>
<tr>
<td>3. Click the row selector to the left of the row containing the index you want to delete. <em>The row is selected.</em></td>
<td>Click the row selector to the left of the <strong>Prod ID</strong> field in the <strong>Index Name</strong> column</td>
</tr>
<tr>
<td>4. Press <strong>[Delete]</strong>. <em>The index is deleted.</em></td>
<td>Press <strong>[Delete]</strong></td>
</tr>
</tbody>
</table>

Close the Indexes window. Close the table without saving the changes.
CREATING A MULTIPLE FIELD PRIMARY KEY

Discussion

There are times when it is not possible to uniquely identify fields with the values in a single field. Therefore, Access allows you to create a primary key using multiple fields.

When you set a primary key using multiple fields, the combination of the information in the fields must be unique. For example, a table that contains line items for customer orders may have an order number that is entered for each customer. Because you will most likely have multiple customers with multiple orders, the order number associated with each customer may not be unique. Also, a particular item number may appear in multiple orders. Therefore, the item numbers may not be unique. Thus, you cannot create a primary index on either of these fields by themselves. The solution is to create a primary key index on both fields, which allows each item to appear only once on each order.

Creating a multiple field primary key

Procedures

1. Open the desired table in Design view.
2. Point to the row selector to the left of the row containing the first field for the primary key.
3. Click the row selector to the left of the row containing the first field for the primary key.
4. Hold the [Ctrl] key and point to the row selector for the second primary key field.

5. Click the row selector for the second primary key field and release the [Ctrl] key.

6. Click the **Primary Key** button in the **Tools** group on the **Design** tab.

---

**Step-by-Step**

Create a multiple field primary key.

Open the **Line Items** table in **Design** view.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Point to the row selector to the left of the row containing the first field for the primary key. <em>The mouse pointer changes into a black, horizontal arrow pointing to the right.</em></td>
<td>Point to the row selector to the left of the <strong>Order Number</strong> field in the <strong>Field Name</strong> column</td>
</tr>
<tr>
<td>2. Click the row selector to the left of the row containing the first field for the primary key. <em>The row is selected.</em></td>
<td>Click the row selector to the left of the <strong>Order Number</strong> field in the <strong>Field Name</strong> column</td>
</tr>
<tr>
<td>3. Hold the [Shift] key and point to the row selector for the second primary key field. <em>The mouse pointer changes into a black, horizontal arrow pointing to the right.</em></td>
<td>Hold [Shift] and point to the row selector to the left of the <strong>Product ID</strong> field in the <strong>Field Name</strong> column</td>
</tr>
<tr>
<td>4. Click the row selector for the second primary key field and release the [Shift] key. <em>The row is selected.</em></td>
<td>Click the row selector to the left of the <strong>Product ID</strong> field in the <strong>Field Name</strong> column and release [Shift]</td>
</tr>
</tbody>
</table>
5. Click the **Primary Key** button in the tools group on the **Design** tab. A key symbol appears in the row selector next to each selected row.

Open the Indexes window and view the index you created. Close the Indexes window. Then, close the table without saving the changes. Close **INDEX1.ACCDB**.
EXERCISE

WORKING WITH INDEXES

Task

Work with indexes.

1. Open INDEX1X.ACCDB.
2. Open the Invoice table in Design view.
3. Index the Client ID field, allowing duplicates.
4. Open the Indexes window.
5. Create a multiple field index called Client/Project. The first field in the index should be Client ID and the second field should be Project ID. Use the Ascending sort order for both.
6. Close the Indexes window. Then, close the Invoice table without saving the changes.
7. Open the Project table in Design view.
8. Open the Indexes window and delete the existing indexes. Close the Indexes window.
9. Create a multiple field primary key that includes the Project ID and Client ID fields.
10. Open the Indexes window to view the primary key fields. Then, close the Indexes window.
11. Close the Project table without saving the changes.
LESSON 6 -
USING ACCESS AND THE INTERNET

In this lesson, you will learn how to:

- Work with hyperlinks
- Create a hyperlink field
- Insert a hyperlink field
- Edit a hyperlink field
- Delete a hyperlink field
WORKING WITH HYPERLINKS

Discussion

Access 2007 supports the use of hypertext within the application. Hypertext, or hyperlinks, are strings of text that declare an address or a path to a file. Hypertext is active in that, if you click it, your PC and/or modem lead you to the file. Hyperlinks provide an electronic path to files in much the same way as your home address provides a path for the mail you receive. For example, by reading the address, the postal service knows to first go to Pennsylvania, then to Pittsburgh, then to Forbes Avenue, and then to house number 2250.

Hyperlinks can be a URL address or a UNC address. The URL (Uniform Resource Locator) is the address of a resource, or file, available on the Internet or your intranet. The URL contains the protocol of the resource (e.g. http:// or ftp://), the domain name for the resource, and the hierarchical name for the file (address). For example, a page on the Internet may be at the URL http://www.globalknowledge.com/terms/url.shtml. The beginning part, http:// provides the protocol, the next part www.globalknowledge.com is the domain, the main domain is globalknowledge, while www is a pointer to a computer or a resource. The rest, /terms/url.shtml is the pointer to the specific file on that server. Domain extensions identify the source; .com for companies, .org for organizations, .gov for government, and .edu for educational institutions.

A UNC (Universal Naming Convention) is the address to a shared file in a computer without having to specify (or know) the storage device it is on. The UNC can be used instead of the local naming system. In Windows operating systems, the UNC name format is: \servername\sharename\path\filename. The share name logically identifies the storage device where the file is located. For example: \corp1\acctdept\forms\triprpt.xls might specify on a server in the corporate main office where a shared file (triprpt.xls) is kept with other accounting forms that employees of the corporation might download and read or print and use. A UNC hyperlink, when clicked, launches Access and opens the file in the designated folder. Similarly, when you click a URL hyperlink address, Access activates the application you use to navigate the Internet and takes you to that site.

CREATING A HYPERLINK FIELD

Discussion

You can add hyperlinks to tables by adding a field name and identifying it as a hyperlink data type. You can then add hyperlinks to the appropriate column allowing you to jump to objects in the same database, in another database, in other Microsoft Office documents, on the Internet, or on an intranet.
Procedures

1. Open the desired table in **Design** view.
2. Select the first blank row in the **Field Name** column.
3. Type the desired field name.
4. Press **[Tab]**.
5. Select the **Data Type** list.
6. Select the **Hyperlink** data type.

Step-by-Step

From the Student Data directory, open **HYPERL1.ACCDB**.
Create a hyperlink field.

Open the **Items** table in **Design** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the first blank row in the <strong>Field Name</strong> column. The insertion point appears in the first blank row in the column.</td>
<td>Click in the first blank row in the <strong>Field Name</strong> column</td>
</tr>
<tr>
<td>2. Type the desired field name. The field name appears in the <strong>Field Name</strong> column.</td>
<td>Type <strong>Linking to</strong></td>
</tr>
<tr>
<td>3. Press <strong>[Tab]</strong>. The insertion point appears in the <strong>Data Type</strong> column and an arrow appears to the right of the field.</td>
<td>Press <strong>[Tab]</strong></td>
</tr>
<tr>
<td>4. Select the <strong>Data Type</strong> list. A list of available data types is displayed.</td>
<td>Click <strong>Data Type</strong></td>
</tr>
<tr>
<td>5. Select the <strong>Hyperlink</strong> data type. The <strong>Hyperlink</strong> data type appears in the <strong>Data Type</strong> column.</td>
<td>Click <strong>Hyperlink</strong></td>
</tr>
</tbody>
</table>

Close and save the table.
INSERTING A HYPERLINK FIELD

Discussion

You can insert a hyperlink into a field in a table or form. However, the field data type must be designated as **Hyperlink**. The default settings display a new hyperlink in blue underlined text and a followed hyperlink (one that has been used) in purple underlined text. When you click the label, the hyperlink path is followed to the specified location. The file at the end of the path can be a web page for company headquarters in Los Angeles, or a file located on your hard drive. For example, in the header of an Annual Sales Report, you can insert hyperlink labels that, when activated, open related spreadsheets, such as a Quarterly Sales Report for that year. Another example is to create a hyperlink label for a **Product** field on a form that jumps to a listing of products on your supplier’s web page.

Hyperlink labels in forms or reports must contain a viable path, but the path itself does not need to be displayed on the label. As with hyperlink fields, you can display a label with descriptive text rather than the actual path.

When you point to a hyperlink, the mouse pointer changes into a hand pointing upward, signifying that one mouse click activates the hyperlink.

![The Insert Hyperlink dialog box](image)

Procedures

1. Open the desired table in **Datasheet** view.
2. Right-click the desired row in the hyperlink column.
3. Point to **Hyperlink**.
4. Select **Edit Hyperlink**....
5. Select the desired option in the **Link to:** bar.

6. Select the desired file or page.

7. Select **OK**.

---

### Step-by-Step

Insert a hyperlink field to a file in the same folder.

Open the **Items** table in **Datasheet** view.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Right-click the desired row in the hyperlink column. <em>The shortcut menu is displayed.</em></td>
<td>Right-click in the first row in the <strong>Linking to</strong> column.</td>
</tr>
<tr>
<td>2. Point to <strong>Hyperlink.</strong> <em>The <strong>Hyperlink</strong> submenu is displayed.</em></td>
<td>Click <strong>Hyperlink</strong></td>
</tr>
<tr>
<td>3. Select <strong>Edit Hyperlink....</strong> <em>The Insert Hyperlink dialog box opens.</em></td>
<td>Click <strong>Edit Hyperlink...</strong></td>
</tr>
<tr>
<td>4. Select the desired option button in the <strong>Link to:</strong> bar. <em>The options on the right side of the dialog box change accordingly.</em></td>
<td>Click <strong>Existing File or Web Page</strong></td>
</tr>
<tr>
<td>5. Select the desired file or page. <em>The desired object type expands to display a list of objects.</em></td>
<td>Click <strong>Current Folder</strong>, if necessary</td>
</tr>
<tr>
<td>6. Select the desired file or page to which you want to link. <em>The file or page selected appears in the <strong>Text to display</strong> box and <strong>Address</strong> boxes.</em></td>
<td>Click <strong>DISCLIST.XLSX</strong></td>
</tr>
<tr>
<td>7. Select <strong>OK.</strong> <em>The Insert Hyperlink dialog box closes and the hyperlink appears in blue underlined text in the hyperlink column.</em></td>
<td>Click <strong>OK</strong></td>
</tr>
</tbody>
</table>

Click any cell in the datasheet window to deselect the hyperlink.
Point to the DISCLIST.XLSX hyperlink. When the mouse pointer changes into a hand pointing upward, click the hyperlink to activate it. Notice that a Microsoft Office Access warning box opens to warn you that hyperlinks can be harmful. Select Yes and notice that the DISCLIST.XLSX worksheet opens in Excel. Close the worksheet and Excel. Click any cell in the datasheet window to deselect the hyperlink. Notice that the hyperlink now appears in purple underlined text.

## EDITING A HYPERLINK FIELD

### Discussion

You may occasionally have to edit your hyperlinks. Changes to the text to be displayed, in web addresses, and any file location changes on your PC or server need to be reflected with an updated hyperlink. You can edit the **Text to display** and the **Address** location, or change the **Link to** option.

When you edit most text in Access, you click or double-click the text and then make the necessary changes. By design, hyperlinks are activated when clicked and, therefore, must be edited differently.

### Procedures

1. Open the desired table or form in **Datasheet** view.
2. Point to the hyperlink you want to edit.
3. Right-click the hyperlink you want to edit.
4. Point to **Hyperlink**.
5. Select **Edit Hyperlink**....
6. Select the item to be changed.
7. Modify the link as desired.
8. Select **OK**.

### Step-by-Step

Edit a hyperlink field.

If necessary, open the **Items** table in **Datasheet** view.
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Point to the hyperlink you want to edit. The mouse pointer changes into a hand pointing upward.</td>
<td>Point to the DISCLIST.XLSX hyperlink</td>
</tr>
<tr>
<td>2. Right-click the hyperlink you want to edit. The shortcut menu is displayed.</td>
<td>Right-click the DISCLIST.XLSX hyperlink</td>
</tr>
<tr>
<td>3. Point to Hyperlink. The Hyperlink submenu is displayed.</td>
<td>Point to Hyperlink</td>
</tr>
<tr>
<td>4. Select Edit Hyperlink.... The Edit Hyperlink dialog box opens.</td>
<td>Click Edit Hyperlink...</td>
</tr>
<tr>
<td>5. Select the item to be changed. The desired item is selected.</td>
<td>Drag to select DISCLIST.XLSX in the Text to display box</td>
</tr>
<tr>
<td>6. Modify the link as desired. The item is modified.</td>
<td>Type Team Discounts</td>
</tr>
<tr>
<td>7. Select OK. The Edit Hyperlink dialog box closes and the new hyperlink appears in the hyperlink column.</td>
<td>Click OK</td>
</tr>
</tbody>
</table>

Click any cell in the datasheet window to deselect the hyperlink.

**DELETING A HYPERLINK FIELD**

**Discussion**

If a hyperlink becomes invalid, or is no longer of any use, it can be deleted. As with editing a hyperlink, you cannot simply double-click a hyperlink to select it.

You can also delete a hyperlink by selecting it and pressing the [Delete] key.
Procedures

1. Open the desired table or form in **Datasheet** view.
2. Point to the hyperlink you want to delete.
3. Right-click the hyperlink you want to delete.
4. Point to **Hyperlink**.
5. Select **Edit Hyperlink**.
6. Select the **Remove Link** button.

Step-by-Step

Delete a hyperlink field.

If necessary, open the **Items** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Point to the hyperlink you want to delete.</td>
<td><strong>Point to the Team Discounts</strong> hyperlink</td>
</tr>
<tr>
<td><em>The mouse pointer changes into a hand pointing upward.</em></td>
<td></td>
</tr>
<tr>
<td>2. Right-click the hyperlink you want to delete.</td>
<td><strong>Right-click the Team Discounts</strong> hyperlink</td>
</tr>
<tr>
<td><em>The shortcut menu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>3. Point to <strong>Hyperlink</strong>.</td>
<td><strong>Point to Hyperlink</strong></td>
</tr>
<tr>
<td><em>The <strong>Hyperlink</strong> submenu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select <strong>Edit Hyperlink</strong>...</td>
<td>**Click <strong>Edit Hyperlink</strong>...</td>
</tr>
<tr>
<td><em>The <strong>Edit Hyperlink</strong> dialog box opens.</em></td>
<td></td>
</tr>
<tr>
<td>5. Select the <strong>Remove Link</strong> button.</td>
<td><strong>Click</strong> Remove Link</td>
</tr>
<tr>
<td><em>The <strong>Edit Hyperlink</strong> dialog box closes and the hyperlink is deleted from the table or form.</em></td>
<td></td>
</tr>
</tbody>
</table>

Close the table.
Close **HYPERL1.ACCDB**.
EXERCISE

USING ACCESS AND THE INTERNET

Task

Use Access and the Internet.

1. Open HYPERL1X.ACCDB.

2. Create a field called Linked to with a Hyperlink data type in the Client table.

3. Insert a hyperlink in the Client table to CREDIT.DOCX in the student data folder. *(Note: You choose which Client to apply this to.)*

4. Click the hyperlink text to display the CREDIT.DOCX document. Close the document and Microsoft Word.

5. Delete the hyperlink to the CREDIT.DOCX document.

6. Delete the hyperlink column.

7. Close the database file without saving.
LESSON 7 - USING ACCESS DATABASE SECURITY

In this lesson, you will learn how to:

- Encrypt a database with a password
- Open and decrypt a database
- Remove a database password
ENCRYPTING A DATABASE WITH A PASSWORD

Discussion

You can encrypt an Access database to protect it from unauthorized use. Ideally, it is a better practice to encrypt a secured database, as any user can open and work with objects in a database where no security measures or permissions have been defined. When you encrypt a database, Access compresses it, and it becomes unreadable by utility programs or word processors. Decrypting a database removes the encryption.

You can assign a password to a database so that only those users who know the password can open or make changes to the database. Assigning a password protects the database, not the database objects from unauthorized users. Database objects are protected when user-level security is established.

Passwords are case-sensitive and can be up to 20 characters. They can contain any combination of letters, numbers, symbols, and spaces, excluding the characters "\ [ ] : | < > + = ; , . ? * , leading spaces, and ASCII 10-31 control characters.

A database must be open for exclusive use in order to assign or remove a password. After a password has been assigned, you are prompted for the password each time you open the database.

In Access 2007, password protection and encryption are combined in one easy step. The new encryption feature only applies to files with the .accdb file extension, and uses stronger algorithms than previous versions of Access.

If you choose to encrypt an older database (with the .mdb file extension), Access 2007 uses password and encoding features from Access 2003.
If you forget the assigned password, you cannot open the database.

Procedures

1. Open the desired database in **Exclusive** mode.
2. Select the **Database Tools** tab on the **Ribbon**.
3. Select the **Encrypt with Password** button in the **Database Tools** group.
4. Type a password for the encrypted database in the **Password** box.
5. Press **[Tab]**.
6. Type the same password in the **Verify** box.
7. Select **OK**.

Step-by-Step

From the Student Data directory, open **ENCRYPT.ACCDB**. Encrypt a database with a password.

The database must be opened in **Exclusive** mode. This is done from within Access. Click the **Office** button and navigate to the file from the **Open** option. Click on the arrow on the right hand part of the **Open** button and select **Open Exclusive**.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Database Tools</strong> tab.</td>
<td>Click <strong>Database Tools</strong></td>
</tr>
<tr>
<td><em>The <strong>Database Tools</strong> tab is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select the <strong>Encrypt with Password</strong> button in the <strong>Database Tools</strong> group.</td>
<td>Click <strong>Encrypt with Password</strong></td>
</tr>
<tr>
<td><em>The Set Database Password dialog box opens.</em></td>
<td></td>
</tr>
</tbody>
</table>
**Steps** | **Practice Data**
--- | ---
3. Type a password for the encrypted database in the **Password** box. *Asterisks appear in the Password box, one for each character in the password.* | Type **securenc**
4. Press [Tab]. *The cursor moves to the **Verify** box.* | Press [Tab]
5. Type the same password in the **Verify** box. *Asterisks appear in the Verify box, one for each character in the password.* | Type **securenc**
6. Select **OK**. *The Set Database Password dialog box closes and the database is encrypted with the password.* | Click **OK**

---

**OPENING AND DECRYPTING A DATABASE**

**Discussion**

When you click to open an encrypted database, Access will prompt you to enter a password. If you type the correct password, the database will open, and the encryption will be removed. If you type an incorrect password, the database will remain closed and encrypted.

**Procedures**

1. Open the desired encrypted database.
2. Type the password in the **Enter database password** box.
3. Select **OK**.
Step-by-Step

Open and decrypt an encrypted database.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Type the password in the <strong>Enter database password:</strong> box. Asterisks appear in the <strong>Enter database password:</strong> box, one for each character in the password.</td>
<td>Type <em>securenc</em></td>
</tr>
<tr>
<td>2. Select <strong>OK</strong>.</td>
<td>Click <strong>OK</strong></td>
</tr>
</tbody>
</table>

**Removing a Database Password**

Discussion

If a password is no longer necessary, you can remove it from the database. You can then open the database at any time without a password.

Procedures

1. Open the desired encrypted database.
2. Select the **Database Tools** tab on the **Ribbon**.
3. Select the **Decrypt Database** button in the **Database Tools** group.
4. Type the desired password.
5. Select **OK**.
Step-by-Step

Remove a password from an existing database.

Open the database, if necessary. Type `securenc` in the Password Required dialog box and select OK to open the database.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Database Tools** tab on the **Ribbon**.  
*The Database Tools tab is displayed.* | Click **Database Tools** |
| 2. Select the **Decrypt Database** button in the **Database Tools** group.  
*The Unset Database Password dialog box opens with the insertion point in the Password box.* | Click **Decrypt Database** |
| 3. Type the desired password.  
*Asterisks appear in the Password box, one for each character in the password.* | Type **securenc** |
| 4. Select **OK**.  
*The Unset Database Password dialog box closes, and the password is removed from the database.* | Click **OK** |

Close **ENCRYPT.ACCDB**.
EXERCISE

USING ACCESS DATABASE SECURITY

Task

Use Access database security.

1. Open ENCRYPTX.ACCDB in Exclusive mode.
2. Encrypt the ENCRYPTX.ACCDB database with the password pass102.
3. Close the database.
4. Open ENCRYPTX.ACCDB. Notice you must enter the password.
5. Decrypt the ENCRYPTX.ACCDB database.
6. Close the database.
LESSON 8 - CREATING MACROS

In this lesson, you will learn how to:

- Work with macros
- Open the Macro Tools window
- Create a macro
- Display macro design arguments
- Assign an argument to an action
- Save a macro
- Use single step mode for testing
- Run a macro
- Edit an existing macro
WORKING WITH MACROS

Discussion

A macro performs a set of commands in sequence. While macros in word processors and spreadsheets are used mainly to duplicate keystrokes or mouse movements, macros in Access often automate an action or a series of actions. Such actions include opening tables, printing forms, finding records, or applying filters. Macros can even be used to add command buttons, create menus and toolbars, and build complete applications.

Macro commands in Access consist of an action and its arguments. The action is the task to be performed, such as opening a form. The arguments determine the specifics for the action, such as which form to open.

You create a macro in Access in the Macro Tools window. This window has two panes. The upper pane, called the Action pane, contains a design grid. The design grid can contain up to four columns. The Action and Comment columns are always displayed. The Action column contains one of the many available macro commands. In the Comment column, you can type a description of the action. Comments are helpful when you are editing macros that contain many actions. You can also display the Macro Name and Condition columns. The Macro Name column contains a name for a macro that can be referred to during events, such as clicking a command button. You can execute a macro conditionally by adding a statement to the Condition column. The lower pane, called the Action Arguments pane, contains the arguments. The arguments listed change, depending on what action is selected.

OPENING THE MACRO TOOLS WINDOW

Discussion

The design grid in the Action pane of the Macro Tools window contains at least two columns: Action and Comment. In the Action column, you enter the actions you want the macro to perform. You can either type the name of the action or select one from the list. In the Comment column, you describe the purpose of the action. Adding a comment may not seem important when a macro is first created, but it can prove helpful if you need to edit the macro at a later time.
The **Action Arguments** pane appears at the bottom of the window and varies according to the action selected in the **Action** pane. Most actions require one or more arguments. In the **Action Arguments** pane, the arguments pertaining to an action appear. The arguments detail exactly what function the action performs.

![The Action pane and Arguments pane in the Macro Tools window](image)

**Procedures**

1. Select the **Create** tab on the **Ribbon**.

2. Select the top part of the **Macro** button in the **Other** group.

**Step-by-Step**

From the Student Data directory, open **MACROS1.ACCDB**. Open the Macro Tools window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Create** tab on the **Ribbon**.  
*The Create tab is displayed.* | Click **Create** |
Steps | Practice Data
---|---
2. Select the top part of the Macro button in the Other group. The Macro Tools window opens. | Click

Notice that the Action Arguments pane is blank since no macros have been created and no actions are selected.

## CREATING A MACRO

### Discussion

When you select a field in the Action column, a list of actions appears. Most of the actions are self-explanatory and have equivalent menu commands. For instance, the OpenQuery action opens a query in Datasheet or Design view, depending on how the arguments are set.

Other actions can be performed only in macros or in more complex programming modules. The AddMenu action, for example, creates a custom menu to appear on a custom menu bar.

A macro can include up to 999 actions. You place each action in a separate row in the design grid in the order in which they are to be performed. For example, a Maximize command maximizes the window opened in the step immediately preceding it.

You use the Comment column to enter a description of the action to be performed. This field can contain up to 255 characters. While comments are optional, it is beneficial to enter a description of the action. This field is helpful if you want to modify the macro at a later time.

The following table provides a brief description of each action:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddMenu</td>
<td>Adds a drop-down menu item to a custom menu bar.</td>
</tr>
<tr>
<td>ApplyFilter</td>
<td>Applies a filter or query to restrict or sort records.</td>
</tr>
<tr>
<td>Beep</td>
<td>Sounds a tone through the computer's speaker.</td>
</tr>
<tr>
<td>CancelEvent</td>
<td>Cancels the action that initiated the macro.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes a specified window.</td>
</tr>
<tr>
<td>CloseDatabase</td>
<td>Closes the current database.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FindNext</td>
<td>Locates the next record that meets criteria specified by a find.</td>
</tr>
<tr>
<td>FindRecord</td>
<td>Locates the first record following the current record that meets criteria specified in the arguments.</td>
</tr>
<tr>
<td>GoToControl</td>
<td>Activates the specified field or control.</td>
</tr>
<tr>
<td>GoToPage</td>
<td>Activates the first control on a specified page.</td>
</tr>
<tr>
<td>GoToRecord</td>
<td>Makes the specified record the current record.</td>
</tr>
<tr>
<td>Hourglass</td>
<td>Changes the mouse pointer to an hourglass while the macro is running.</td>
</tr>
<tr>
<td>LockNavigationPane</td>
<td>Prevents users from deleting database objects displayed in the Navigation Pane.</td>
</tr>
<tr>
<td>Maximize</td>
<td>Enlarges the active window to fill the screen.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Reduces the active window to a button on the taskbar.</td>
</tr>
<tr>
<td>MoveSize</td>
<td>Moves and/or resizes the active window.</td>
</tr>
<tr>
<td>MsgBox</td>
<td>Opens a message box containing a warning or informative text.</td>
</tr>
<tr>
<td>NavigateTo</td>
<td>Controls the display of database objects in the Navigation Pane.</td>
</tr>
<tr>
<td>OnError</td>
<td>Specifies what happens when an error occurs in a macro.</td>
</tr>
<tr>
<td>OpenForm</td>
<td>Opens a form in the selected view.</td>
</tr>
<tr>
<td>OpenQuery</td>
<td>Opens a query in the selected view.</td>
</tr>
<tr>
<td>OpenReport</td>
<td>Opens a report in the selected view.</td>
</tr>
<tr>
<td>OpenTable</td>
<td>Opens a table in the selected view.</td>
</tr>
<tr>
<td>OutputTo</td>
<td>Outputs data in the specified object to Excel text (.XLSX), rich-text (.RTF), or MS-DOS text (.TXT).</td>
</tr>
<tr>
<td>Quit</td>
<td>Quits Access.</td>
</tr>
<tr>
<td>RemoveAllTempVars</td>
<td>Removes any temporary variables created with the SetTempVar action.</td>
</tr>
<tr>
<td>RemoveTempVar</td>
<td>Removes a single temporary variable created with the SetTempVar action.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RepaintObject</td>
<td>Completes any pending screen updates for the active or specified object.</td>
</tr>
<tr>
<td>Requery</td>
<td>Updates the data in a specified control of an active object or updates itself if no control is specified.</td>
</tr>
<tr>
<td>Restore</td>
<td>Restores a maximized or minimized window to its previous size.</td>
</tr>
<tr>
<td>RunCode</td>
<td>Runs a Microsoft Access Basic Function procedure.</td>
</tr>
<tr>
<td>RunCommand</td>
<td>Performs a menu command.</td>
</tr>
<tr>
<td>RunMacro</td>
<td>Runs a macro.</td>
</tr>
<tr>
<td>SearchForRecord</td>
<td>Searches for a specific record in a table, query, form or report.</td>
</tr>
<tr>
<td>SelectObject</td>
<td>Selects an object.</td>
</tr>
<tr>
<td>SetDisplayedCategories</td>
<td>Specifies which categories are displayed under Navigate to Category in the title bar of the Navigation Pane.</td>
</tr>
<tr>
<td>SetMenuItem</td>
<td>Sets the appearance of a command that appears in a custom menu.</td>
</tr>
<tr>
<td>SetProperty</td>
<td>Sets a property for a control on a form or report.</td>
</tr>
<tr>
<td>SetTempVar</td>
<td>Creates a temporary variable and sets it to a specific value.</td>
</tr>
<tr>
<td>ShowAllRecords</td>
<td>Removes any applied filter from the applicable active object and displays all records.</td>
</tr>
<tr>
<td>SingleStep</td>
<td>Pauses macro execution and opens the Macro Single Step dialog box.</td>
</tr>
<tr>
<td>StopAllMacros</td>
<td>Stops all currently running macros.</td>
</tr>
<tr>
<td>StopMacro</td>
<td>Stops the currently running macro.</td>
</tr>
</tbody>
</table>
Adding an action and a comment to a macro

You can use the [Tab] key and the [Shift+Tab] key combination to navigate between the Action, Arguments and Comment columns.

Procedures

1. Open the desired database.
2. Open the Macro Tools window.
3. Select the first blank field in the Action column.
4. Select the Action list.
5. Select the desired action.
6. Select the corresponding field in the Comment column next to the action.
7. Type a description for the action.

Step-by-Step

Create a macro.
If necessary, open the Macro Tools window by selecting the top part of the Macro button in the Other group on the Create tab.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the first blank field in the Action column. The insertion point appears in the appropriate field in the Action column and an arrow appears to the right of the field.</td>
<td>Click in the first blank field in the Action column, if necessary</td>
</tr>
<tr>
<td>2. Select the Action list. A list of actions is displayed.</td>
<td>Click Action ▼</td>
</tr>
<tr>
<td>3. Select the desired action. The action appears in the field and a list of corresponding arguments appears in the Action Arguments pane.</td>
<td>Scroll as necessary and click OpenForm</td>
</tr>
<tr>
<td>4. Select the corresponding field in the Comment column next to the action. The insertion point appears in the appropriate field in the Comment column.</td>
<td>Click the corresponding field in the Comment column next to the OpenForm action</td>
</tr>
<tr>
<td>5. Type a description for the action. The text appears in the Comment field.</td>
<td>Type Opens the Order Entry Form</td>
</tr>
</tbody>
</table>

**Practice the Concept:** Add the MoveSize action to the second row of the Action column. Enter the text Sizes the window in the corresponding field in the Comment column.

Close MACROS1.ACCDB.

**DISPLAYING MACRO DESIGN ARGUMENTS**

**Discussion**

In Access 2007, the Macro Tools window has a new Arguments column, which allows you to view an argument assigned to an action on the same line as the action.

You can choose to show or hide the Arguments column, as desired.
The buttons in the Show/Hide group on the Macro Tools Design contextual tab are toggles. For example, you can click on the Arguments button to display the Arguments column, then click the Arguments button again to hide the Arguments column.

ASSIGNING AN ARGUMENT TO AN ACTION

Discussion

Most action arguments have a default list of available arguments. For example, the View argument field for the OpenReport action contains a list with theDatasheet, Design, Print Preview, PivotChart, and PivotTable arguments. For action arguments without a list, you can type the argument into the argument field. You can enter up to 255 characters into the argument field.

Some arguments are required. For example, you must select the Form Name argument for the OpenForm action. Other arguments, such as Filter Name, are not required for the OpenForm action. If a required argument is missing, the macro stops when the action containing the missing argument is encountered.

In some cases, a default argument is used. For example, the View argument defaults to Form for the OpenForm action. Other arguments are ignored if they are not selected. For example, the Filter Name argument allows you to select a query to apply to the form as a filter. If you do not enter a query name, all the records appear.

With forms, you can also specify a Where Condition argument. This argument acts as a filter, without using an actual query. For example, the argument \([\text{Credit Limit}] = 1000\) limits records to those with a credit limit of $1000. You can type the condition directly into the argument box or click the Build button in the argument box to open the Expression Builder dialog box.

Access displays a helpful message explaining the selected argument to the right of the argument boxes. If you press the [F1] key while the insertion point is in the Action Arguments pane of the Macro Tools window, a help window for the argument opens with additional information.

The available macro actions and their associated arguments are listed in the following table. When the text (req.) appears next to an item in the Arguments column, either an argument or a selection from a list is required for the macro to run properly:
<table>
<thead>
<tr>
<th>Action</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddMenu</td>
<td>Menu Name (req.), Menu Macro Name (req.), Status Bar Text</td>
</tr>
<tr>
<td>ApplyFilter</td>
<td>Filter Name, Where Condition (one or both req.)</td>
</tr>
<tr>
<td>Beep</td>
<td>None</td>
</tr>
<tr>
<td>CancelEvent</td>
<td>None</td>
</tr>
<tr>
<td>Close</td>
<td>Object Type, Object Name, Save (req.)</td>
</tr>
<tr>
<td>CloseDatabase</td>
<td>None</td>
</tr>
<tr>
<td>FindNext</td>
<td>None</td>
</tr>
<tr>
<td>FindRecord</td>
<td>Find What (req.), Match (req.), Match Case (req.), Search (req.), Search As Formatted (req.), Only Current Field (req.), Find First (req.)</td>
</tr>
<tr>
<td>GoToControl</td>
<td>Control Name (req.)</td>
</tr>
<tr>
<td>GoToPage</td>
<td>Page Number (req.), Right, Down (if a Right is specified, a Down must be specified and vice versa)</td>
</tr>
<tr>
<td>GoToRecord</td>
<td>Object Type, Object Name, Record (req.), Offset</td>
</tr>
<tr>
<td>Hourglass</td>
<td>Hourglass On (req.)</td>
</tr>
<tr>
<td>LockNavigationPane</td>
<td>Lock</td>
</tr>
<tr>
<td>Maximize</td>
<td>None</td>
</tr>
<tr>
<td>Minimize</td>
<td>None</td>
</tr>
<tr>
<td>MoveSize</td>
<td>Right, Down, Width, Height</td>
</tr>
<tr>
<td>MsgBox</td>
<td>Message, Beep (req.), Type (req.), Title</td>
</tr>
<tr>
<td>NavigateTo</td>
<td>Category, Group</td>
</tr>
<tr>
<td>OnError</td>
<td>Go To, Macro Name</td>
</tr>
<tr>
<td>OpenForm</td>
<td>Form Name (req.), View (req.), Filter Name, Where Condition, Data Mode (req.), Window Mode (req.)</td>
</tr>
<tr>
<td>OpenQuery</td>
<td>Query Name (req.), View (req.), Data Mode (req.)</td>
</tr>
<tr>
<td>OpenReport</td>
<td>Report Name (req.), View (req.), Filter Name, Where Condition</td>
</tr>
<tr>
<td>OpenTable</td>
<td>Table Name (req.), View (req.), Data Mode (req.)</td>
</tr>
<tr>
<td>OutputTo</td>
<td>Object Type (req.), Object Name, Output Format, Output File, Auto Start, Template File</td>
</tr>
<tr>
<td>Quit</td>
<td>Options (req.)</td>
</tr>
<tr>
<td>Action</td>
<td>Arguments</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>RemoveAllTempVars</td>
<td>None</td>
</tr>
<tr>
<td>RemoveTempVar</td>
<td>Name</td>
</tr>
<tr>
<td>RepaintObject</td>
<td>Object Type, Object Name</td>
</tr>
<tr>
<td>Requery</td>
<td>Control Name</td>
</tr>
<tr>
<td>Restore</td>
<td>None</td>
</tr>
<tr>
<td>RunCode</td>
<td>Function Name (req.)</td>
</tr>
<tr>
<td>RunCommand</td>
<td>Command (req.)</td>
</tr>
<tr>
<td>RunMacro</td>
<td>Macro Name (req.), Repeat Count, Repeat Expression</td>
</tr>
<tr>
<td>SearchForRecord</td>
<td>Object Type, Object Name, Record, Where Condition</td>
</tr>
<tr>
<td>SelectObject</td>
<td>Object Type (req.), Object Name (req.), In Database Window (req.)</td>
</tr>
<tr>
<td>SetDisplayedCategories</td>
<td>Show, Category</td>
</tr>
<tr>
<td>SetMenuItem</td>
<td>Menu Index (req.), Command Index (req.), Subcommand Index, Flag (req.)</td>
</tr>
<tr>
<td>SetProperty</td>
<td>Control Name, Property, Value</td>
</tr>
<tr>
<td>SetTempVar</td>
<td>Name, Expression</td>
</tr>
<tr>
<td>ShowAllRecords</td>
<td>None</td>
</tr>
<tr>
<td>SingleStep</td>
<td>None</td>
</tr>
<tr>
<td>StopAllMacros</td>
<td>None</td>
</tr>
<tr>
<td>StopMacro</td>
<td>None</td>
</tr>
</tbody>
</table>

Assigning an argument to an action
You can use the [Tab] key and the [Shift+Tab] key combination to navigate through the argument fields.

Procedures

1. Open the desired database.
2. Open the Macro Tools window.
3. Select the action in the Action column to which you want to assign an argument.
4. Select the applicable argument in the Action Arguments pane.
5. Type the argument or select the corresponding list.
6. Select an argument from the list, if applicable.

Step-by-Step

From the Student Data directory, open MACROS1.ACCDB. Assign an argument to an action.

If necessary, open the Macro Tools window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the action in the Action column to which you want to assign an argument. The insertion point appears in the appropriate Action field and the Action Arguments pane changes accordingly.</td>
<td>Click OpenForm</td>
</tr>
<tr>
<td>2. Select the applicable argument in the Action Arguments pane. The insertion point appears in the appropriate argument field and an arrow appears to the right of the field.</td>
<td>Click in the Form Name argument field</td>
</tr>
<tr>
<td><strong>Steps</strong></td>
<td><strong>Practice Data</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>------------------</td>
</tr>
</tbody>
</table>
| 3. Type the argument or select the corresponding list.  
*The argument appears in the argument field or a list of arguments is displayed.* | Click **Form Name** |
| 4. Select an argument from the list, if applicable.  
*The argument appears in the argument box.* | Click **Order Entry** |

**Practice the Concept:** Continue to assign the arguments for this action by setting the arguments for **View** to **Form**, **Data Mode** to **Read Only**, and **Window Mode** to **Normal**.

Select the **MoveSize** action in the **Action** pane. Set the arguments for **Right** to 0”, **Down** to 0”, **Width** to 5.5” and **Height** to 2” (The units (“”) mark does not have to be entered; Access will add it automatically.)

## SAVING A MACRO

### Discussion

After creating a macro, you must save it before you can test or run it. When you attempt to save a macro or close the Macro window without saving, a Save As dialog box opens with the default name of **Macro#** (numbered consecutively). It is best to use a short name that clearly indicates the function of the macro. The name **Macro1**, for example, does not mean much to other users who may be working with the macro.

The name that you give the macro appears in the **Macros** object list in the Navigation Pane.

You can rename a macro. However, if you rename a macro, it may no longer run, depending on how you initiate the macro. Instead, it is a good idea to copy a macro, rename it, and then edit it in order to create macros that perform similar tasks.
Lesson 8 - Creating Macros

Procedures

1. Open the desired database.
2. Create the desired macro.
3. Click the **Save** button on the **Quick Access Toolbar**.
4. Type a name for the macro.
5. Select **OK**.

Step-by-Step

Save a macro.

If necessary, open the **Order Form** macro by clicking on the **Open Form** macro row in the Macro Tools window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Save</strong> button on the <strong>Quick Access Toolbar</strong>.</td>
<td>Click <img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td><em>The Save As dialog box opens with the text in the <strong>Macro Name</strong> box selected.</em></td>
<td></td>
</tr>
<tr>
<td>2. Type a name for the macro.</td>
<td>Type <strong>Open Order Form</strong></td>
</tr>
<tr>
<td><em>The name appears in the <strong>Macro Name</strong> box.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select <strong>OK</strong>.</td>
<td>Click <img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td><em>The Save As dialog box closes and the macro is saved.</em></td>
<td></td>
</tr>
</tbody>
</table>

**Using Single Step Mode for Testing**

Discussion

Access runs macros so quickly that you may not be able to see each action as it is performed. If you wish to confirm that the actions are being performed correctly, you can step through the macro. Single step mode is particularly useful when a macro
contains numerous actions or arguments, or when a macro does not seem to perform as planned.

When you step through a macro, Access pauses before each action, allowing you to view each step. The Macro Single Step dialog box opens, displaying the macro name, condition, action name, and selected arguments. The Macro Single Step dialog box has three buttons: **Step**, **Stop All Macros**, and **Continue**. You select the **Step** button to perform the action in the dialog box. If there are no errors, the next action appears in the dialog box. If you want to stop running the macro in this mode, you select the **Stop All Macros** button. The macro stops running and the dialog box closes. When you want to stop stepping through the macro and run the remaining steps, you select the **Continue** button. The remaining macro actions are then completed.

If an error does occur, you can make the changes in the Macro Tools window. After you make the changes to a macro, you should retest it.

---

**Procedures**

1. Open the desired database.
2. Open the desired macro in the Macro Tools window.
3. Click the **Single Step** button in the **Tools** group on the **Design** contextual tab.
4. Click the **Run** button in the **Tools** group on the Macro Tools **Design** contextual tab.
5. Select the **Step** button as necessary to complete all the macro actions.
6. Select the **Stop All Macros** button to stop running the macro and close the dialog box.

7. Select the **Continue** button to run the remaining steps.

### Step-by-Step

Use single step mode for testing a macro.

If necessary, open the **Open Order Form** macro in the Macro Tools window.

If you have not been using the **Open Order Form** macro, open the **Open Order Form 1** macro in the Macro Tools window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Single Step</strong> button in the <strong>Tools</strong> group on the <strong>Design</strong> tab. <strong>The Single Step button is activated.</strong></td>
<td><strong>Click</strong> Single Step</td>
</tr>
<tr>
<td>2. Click the <strong>Run</strong> button in the <strong>Tools</strong> group on the <strong>Design</strong> contextual tab. <strong>The Macro Single Step dialog box opens.</strong></td>
<td><strong>Click</strong> Run</td>
</tr>
<tr>
<td>3. Select the <strong>Step</strong> button as necessary to complete all the macro actions. <strong>The first action is performed and the next step appears if there are no errors.</strong></td>
<td><strong>Click</strong> Step as necessary to complete all the macro actions</td>
</tr>
</tbody>
</table>

When the macro actions are complete, close the form window. Click the **Design** tab on the **Ribbon**. Click the **Single Step** button in the **Tools** group to disable single step mode and close the Macro Tools window.
RUNNING A MACRO

Discussion

You can run a macro from the Navigation Pane by right-clicking the desired macro name and selecting Run from the shortcut menu. You can also run a macro by selecting the desired macro name in the Navigation Pane and clicking the Run Macro button on the Database Tools tab on the Ribbon.

A warning box opens if required arguments are missing or if the macro cannot run for any reason.

Procedures

1. Open the desired database.
2. Display All Access Objects in the Navigation Pane, if necessary.
3. Right-click the macro you want to run.
4. Select Run from the shortcut menu.

Step-by-Step

Run a macro from the Database window.

If necessary, display All Access Objects in the Navigation Pane.

If you have not been using the Open Order Form macro, use the Open Order Form 1 macro.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Right-click the macro you want to run. The macro name is selected and the shortcut menu is displayed.</td>
<td>Right-click Open Order Form, if necessary</td>
</tr>
<tr>
<td>2. Select Run. The macro runs.</td>
<td>Click Run</td>
</tr>
</tbody>
</table>
Close the form window.

EDITING AN EXISTING MACRO

Discussion

After you have created a macro, you may decide to add or delete existing actions or change actions or action arguments. In the Macro Tools window, you can cut, copy, and paste to edit a macro. You can also insert and delete rows. After you make the desired changes, you must save the macro to save the changes. It is a good idea to test the edited macro using single step mode. You must remember to disable single step mode after testing a macro.

Procedures

1. Open the desired database.
2. Select All Access Objects in the Navigation Pane, if necessary.
3. Right-click the macro you want to edit.
4. Select Design View from the shortcut menu.
5. Edit the macro as desired.
6. Save the changes to the macro.

Step-by-Step

Edit an existing macro.

If necessary, display All Access Objects in the Navigation Pane.

If you have not been using the Open Order Form macro, use the Open Order Form 1 macro.
Steps | Practice Data
--- | ---
1. Right-click the macro you want to edit. *The macro name is selected and the shortcut menu is displayed.* | Right-click **Open Order Form**, if necessary

2. Select **Design View**. *The Macro Tools window opens.* | Click **Design View**

3. Edit the macro as desired. *The changes appear in the Macro Tools window.* | Follow the instructions shown below the table before continuing on to the next step

4. Save the changes to the macro. *The macro is saved.* | Click ![Image]

Add a third step to the macro. In the Actions pane, use the **OpenQuery** action and add the comment **Opens the Order Items query**. In the Action Arguments pane, set the **Query Name** argument to **Order Items**.

*Return to the table and continue on to the next step (step 4).*

**Practice the Concept:** Add a fourth step to the macro. In the Actions pane, use the **MoveSize** action and add the comment **Sizes and positions the window**. Set the arguments as follows: **Right** to 0, **Down** to 2.25, **Width** to 6.5, and **Height** to 1.5.

Save the macro. Enable single step mode and run the macro. Step through the macro, as necessary. The **Orders** form should open above the **Order Items** query on the screen. Close both windows and disable single step mode. Close the Macro Tools window.

Close **MACROS1.ACCDB**.
EXERCISE

CREATING MACROS

Task

Create, test, and edit a macro.

1. Open **MACROS1X.ACCDB**.

2. Create a new macro. Enter the following actions and comments:

<table>
<thead>
<tr>
<th>Action</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenForm</td>
<td>Opens the Invoice Form</td>
</tr>
<tr>
<td>MoveSize</td>
<td>Sizes the Invoice Form and positions it at the top of the window</td>
</tr>
<tr>
<td>OpenForm</td>
<td>Opens the Payment Form in Datasheet view</td>
</tr>
<tr>
<td>MoveSize</td>
<td>Sizes the Payment Form and positions it below the Invoice Form</td>
</tr>
</tbody>
</table>

3. Enter the following arguments for each action:

<table>
<thead>
<tr>
<th>Action</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenForm</td>
<td>Form Name: <strong>Invoice Form</strong> Data Mode: <strong>Read Only</strong></td>
</tr>
<tr>
<td>MoveSize</td>
<td>Right: 0 Down: 0 Width: 6 Height: 3</td>
</tr>
<tr>
<td>OpenForm</td>
<td>Form Name: <strong>Payment Form</strong> View: <strong>Datasheet</strong> Data Mode: <strong>Read Only</strong></td>
</tr>
<tr>
<td>MoveSize</td>
<td>Right: 0 Down: 3 Width: 6 Height: 2</td>
</tr>
</tbody>
</table>

4. Save the macro as **Open Invoice/Payment Forms**.
5. Enable single step mode and run the macro to test it.

6. Close the Invoice and Payment Form windows.

7. Edit the macro. In the second step, MoveSize, change the Height argument to 2. In the fourth step, MoveSize, change the Down argument to 2.

8. Save the macro and disable single step mode. Close the Macro Tools window.

LESSON 9 - USING MACROS

In this lesson, you will learn how to:

- Use properties
- Create embedded macros
- Assign a macro to a control
- Create a command button
- Add a condition to a macro
- Create a group macro
- Create an Autoexec macro
**USING PROPERTIES**

**Discussion**

Properties allow you to specify the appearance and behavior of objects in a database. Objects include tables, queries, forms, and reports, as well as controls within reports or forms.

Property sheets display the properties of a selected object. They have several tabs including **Format**, **Data**, **Event**, and **Other** that list the properties by group. The groups are the same for every property, but the items in the group change depending on the type of object selected. The **All** page displays all the properties in a single list.

The **Format** properties allow you to control the appearance of an object, such as color, font, size, and borders. These properties change automatically when you make changes to an object. The **Data** properties allow you to specify the source of the data and control items, such as default values. The **Event** properties allow you to control when an action occurs. The **Other** properties contain items that do not fit into the other three categories, such as the name of a control when used in a macro or text that appears in the status bar.

**CREATING EMBEDDED MACROS**

**Discussion**

In Access 2007, you can create embedded macros. When you embed a macro in an event provided by a form, report or control, it is stored in the properties of that event. Therefore, if you export your form or report to another Access database, the embedded macro is included.

You can create an embedded macro using the Macro Builder. Creating a macro using the Macro Builder method requires that you associate the macro with an event, such as **On Click** or **On Close**. When you select an **Event** property, the **Build** button appears. The **Build** button gives you access to the Macro Builder.

- Embedded macros are trusted because they are automatically prevented from performing certain potentially unsafe operations.

- An embedded macro is not visible in the Macros list in the Navigation Pane.
Procedures

1. Open the desired database.
2. Open the desired form or report in Design view.
3. Select the desired object or control to associate the macro.
5. Select the Event tab.
6. Select the desired Event property.
7. Click the Build button.
8. Select Macro Builder from the list box.
9. Select .
10. Select the desired action from the Action drop down list.
11. Add the required arguments in the Action Arguments pane, if necessary, and move to next row.
12. Save the macro.

Step-by-Step

From the Student Data directory, open MACROS2.ACCDB. Create an embedded macro using the Macro Builder.

Open the New Entry form in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the desired object or control to associate with the macro.  
   *Sizing handles appear around the object or control.* | Click the Enter New Record button |
   *The property sheet for the selected object or control opens.* | Press [F4], if necessary |
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>3. Select the <strong>Event</strong> tab.</td>
<td>Click the <strong>Event</strong> tab</td>
</tr>
<tr>
<td><em>The Event page is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select the desired <strong>Event</strong> property.</td>
<td>Click in the <strong>On Click</strong> property</td>
</tr>
<tr>
<td><em>The insertion point appears in the appropriate Event property, and an arrow and a Build button appear to the right of the property.</em></td>
<td></td>
</tr>
<tr>
<td>5. Click the <strong>Build</strong> button.</td>
<td>Click <strong>On Click</strong></td>
</tr>
<tr>
<td><em>The Choose Builder dialog box opens.</em></td>
<td></td>
</tr>
<tr>
<td>6. Select <strong>Macro Builder</strong> from the list box.</td>
<td>Click <strong>Macro Builder</strong></td>
</tr>
<tr>
<td><em>Macro Builder is selected.</em></td>
<td></td>
</tr>
<tr>
<td>7. Select <strong>OK</strong>.</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td><em>The Choose Builder dialog box closes and the Macro Tools window opens with the insertion point in the first field in the Action column</em></td>
<td></td>
</tr>
</tbody>
</table>

Select **GoToRecord** from the **Action** list. Type **New Entry** in the **Comment** column.
In the **Action Arguments** pane, set the arguments for **Object Type** to **Form**, **Object Name** to **New Entry**, and **Record** to **New**. Save and close the Macro Design window. Close the property sheet. Save and close the **New Entry** form.

Open the **New Entry** form in **Form** view and click the **Enter New Record** button.
Close the **New Entry** form.

### Assigning a Macro to a Control

#### Discussion

You can associate a macro with a control on a form or report using the **Event** properties of the control. An event is an action, such as a mouse click or a change in value that can initiate a response. The macro runs automatically when the specified event involving that control occurs.

Many events involve the control having the focus. Focus means that the control can receive data from mouse clicks or keyboard actions. For example, field boxes, toggle buttons, and radio buttons can have the focus, since they can respond to data entry from the keyboard or mouse. Only one control can have the focus at a time. Some of the most commonly used **Event** properties of a text box control are listed in the following table:
<table>
<thead>
<tr>
<th>Event Property</th>
<th>Action is initiated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before Update</td>
<td>before the data in a control is updated</td>
</tr>
<tr>
<td>After Update</td>
<td>after the data in a control is updated</td>
</tr>
<tr>
<td>On Change</td>
<td>when the data in a control is updated</td>
</tr>
<tr>
<td>On Dirty</td>
<td>When the data in a control changes or when you move from one page to another in a tab control</td>
</tr>
<tr>
<td>On Got Focus</td>
<td>when the control gets the focus from another form or control</td>
</tr>
<tr>
<td>On Lost Focus</td>
<td>when the control loses the focus to another control or form</td>
</tr>
<tr>
<td>On Click</td>
<td>by clicking and releasing the primary mouse button on the control</td>
</tr>
<tr>
<td>On Dbl Click</td>
<td>by clicking and releasing the primary mouse button twice on the control</td>
</tr>
<tr>
<td>On Mouse Down</td>
<td>by clicking the mouse button while the mouse pointer is on a control</td>
</tr>
<tr>
<td>On Mouse Move</td>
<td>by moving the mouse pointer over a control</td>
</tr>
<tr>
<td>On Mouse Up</td>
<td>by releasing the mouse button while the mouse pointer is over the control</td>
</tr>
<tr>
<td>On Key Down</td>
<td>by pressing any key on the keyboard when a control has the focus or is using a <em>SendKeys</em> macro</td>
</tr>
<tr>
<td>On Key Up</td>
<td>by releasing a key or immediately after running the <em>SendKeys</em> macro</td>
</tr>
<tr>
<td>On Key Press</td>
<td>by pressing and releasing any key on the keyboard when on a control that has the focus or when using a <em>SendKeys</em> macro</td>
</tr>
<tr>
<td>On Undo</td>
<td>by clicking the <em>Undo Field/Record</em> button on the command bar, clicking the <em>Undo</em> button, pressing the [<em>Esc</em>] key, or calling the Undo method of the specified control</td>
</tr>
</tbody>
</table>

By linking a command button or a control with a macro, you can make commonly used functions easier. Initiating macros this way is particularly useful because it does not require the user to know or use the Access menu structure. For example, you could associate a macro with a command button on a form to print a report. The user could then print the report by clicking the command button, without having to open the report or know the correct menu commands.
Procedures

1. Open the desired database.
2. Open the desired form in **Design** view.
3. Select the desired control.
5. Select the **Event** tab.
6. Select the desired property.
7. Select the property list.
8. Select the desired macro.

Step-by-Step

Assign a macro to a control.

Open the **Customers** form in **Design** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the desired control.  
*Sizing handles appear around the control.* | Click the **Credit Limit** text box control |
The property sheet for the selected control opens. | Press `[F4]`, if necessary |
| 3. Select the **Event** tab.  
The **Event** page is displayed. | Click the **Event** tab, if necessary |
| 4. Select the desired property.  
The insertion point appears in the appropriate property and an arrow and a **Build** button appear to the right of the property. | Click in the **On Got Focus** property |
| 5. Select the property list.  
A list of events for the property is displayed. | Click **On Got Focus** ▼ |
Steps | Practice Data
---|---
6. Select the desired macro. The selected macro appears in the property. | Click Limit

Close the Customers form and save the changes. Open the Customers form in Form view and click the Credit Limit field. Notice that a message box generated by an existing macro opens. Select OK to close the message box. Close the form window.

**CREATING A COMMAND BUTTON**

**Discussion**

Command buttons are controls to which you can assign actions. They are often used to run macros in a form or report. You can place descriptive text or a picture on a command button so that the user can easily identify the purpose of the button.

You create a command button in Design view using the Button button in the Controls group on the Design tab. After you create the command button on the form, you set the properties, such as the event property to initiate the action and the text or picture to appear on the button.

![A command button created on a form](image)
To create a command button to which a macro will be attached, it is recommended that you disable the **Control Wizards** button in the **Controls** group on the **Design** tab.

You can use the Control Wizard to create a command button that allows you to synchronize records between two forms. As you move through records on a form, you can view related records on a second form by clicking the command button.

**Procedures**

1. Open the desired database.
2. Open the desired form or report in **Design** view.
3. Display the **Design** tab on the **Ribbon**, if necessary.
4. If necessary, click the **Control Wizards** button in the **Controls** group to disable it.
5. Click the **Button** button in the **Controls** group.
6. Click in the desired location in the form or report where you want to create the command button.
8. Select the **Event** tab.
9. Select the desired property.
10. Select the property list.
11. Select the desired macro.
12. Select the **Format** tab.
13. Select the text in the **Caption** property.
14. Type the text you want to appear on the button.
Step-by-Step

Create a command button that is attached to a macro.

If necessary, open the Customers form in Design view, display the Design tab on the Ribbon, and click the Control Wizards button in the Controls group to disable it.

If you have not been using the Customers form, open the Customers1 form in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the Button button in the Controls group. The mouse pointer changes into a copy of the tool with a plus sign (+) when positioned over the form or report.</td>
<td>Click Button</td>
</tr>
<tr>
<td>2. Click in the desired location in the form or report where you want to create the command button. The command button appears on the form or report.</td>
<td>Click in the lower left corner of the form</td>
</tr>
<tr>
<td>4. Select the Event tab. The Event page is displayed.</td>
<td>Click the Event tab, if necessary</td>
</tr>
<tr>
<td>5. Select the desired property. The insertion point appears in the appropriate property and an arrow and Build button appear to the right of the property.</td>
<td>Click in the On Click property</td>
</tr>
<tr>
<td>6. Select the property list. A list of events for the property is displayed.</td>
<td>Click On Click</td>
</tr>
<tr>
<td>7. Select the desired macro. The selected macro appears in the property box.</td>
<td>Scroll as necessary and click Phone list</td>
</tr>
<tr>
<td>8. Select the Format tab. The Format page is displayed.</td>
<td>Click the Format tab</td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
9. Select the text in the **Caption** property. *The text in the Caption property is selected.* | Double-click to select the text in the **Caption** property, if necessary

10. Type the text you want to appear on the button. *The text appears in the Caption property.* | Type **Display Phone List**


Close and save the **Customers** form. Open the **Customers** form in **Form** view and click the **Display Phone List** button. Notice that a query window with the customer numbers, contact names, and telephone numbers opens. Close the query and form windows.

**ADDING A CONDITION TO A MACRO**

**Discussion**

You can add a condition argument to a macro. An argument acts very much like a filter. Just as a filter displays only the records that meet the condition, the argument only performs the macro when the condition is met.

Before you can add a condition to a macro, you must display the **Condition** column in the Macro Tools window. The **Condition** column appears to the left of the **Action** column in the upper pane of the Macro Tools window. You can type a condition or use the Expression Builder dialog box to create the expression.

If you type an expression, there are certain rules you must follow when referring to controls in tables, queries, forms, and reports. All references must be separated with an exclamation point. Additional rules for the database objects and controls are listed in the following table:

<table>
<thead>
<tr>
<th>Controls</th>
<th>Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controls in tables</td>
<td>Enclose the name of the table and the name of the control in square brackets and separate them with an exclamation point. For example, <code>[Orders]![Customer ID]</code> refers to the <strong>Customer ID</strong> field in the <strong>Orders</strong> table.</td>
</tr>
</tbody>
</table>
Controls | Rules
---|---
Controls in queries | Enclose the name of the query and the name of the control in square brackets and separate them with an exclamation point. For example, \[Order Items\]![Item Number] refers to the Item Number field in the Order Items query.

Controls in forms | Enclose the name of the form and the name of the control in square brackets and separate them with an exclamation point. Indicate that you are referring to a form by beginning the statement with the word Forms. For example, Forms![Customers]![Customer ID] refers to the Customer ID field in the Customers form.

Controls in reports | Enclose the name of the report and the name of the control in square brackets and separate them with an exclamation point. Indicate that you are referring to a report by beginning the statement with the word Reports. For example, Reports![Customer Sales]![Contact Name] refers to the Contact Name field in the Customer Sales report.

Since you enter the condition in the Condition column in the Macro Tools window, you do not need to include the word IF in the statement. Access assumes the statement is a condition. If the condition is true, Access performs the corresponding action in that row. If the condition is false, Access does not perform the action.
If the condition is true, you can have Access perform more than one action by entering an ellipsis (…) in the **Condition** column in the Macro Tools window. Access performs the action on the same row as the condition and all rows thereafter that contain an ellipsis.

---

**Procedures**

1. Open the desired database.
2. Open the desired macro in the Macro Tools window.
3. Click the **Conditions** button in the **Show/Hide** group on the Macro Tools **Design** tab.
4. Select the field in the **Condition** column next to the applicable action.
5. Type the condition in the field.

---

**Step-by-Step**

Add a condition to a macro.

Open the **Limit** macro in **Design** view.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
</table>
| 1. Click the **Conditions** button in the **Show/Hide** group on the Macro Tools **Design** tab.  
*The Condition column appears to the left of the Action column.* | ![Diagram](image1.png)  
Click **Conditions** |
| 2. Select the field in the **Condition** column next to the applicable action.  
*The insertion point appears in the field.* | Click in the field in the **Condition** column next to the **MsgBox** action, if necessary |
### Using Macros

**Steps**

1. Type the condition in the field.
   
   *The condition appears in the field.*

**Practice Data**

Type `Forms!{Customers1}!{Credit Limit}<3000`.

Expand the **Condition** column, if necessary. Close the Macro Tools window and save the macro. Open the **Customers1** form in **Form** view and click the **Credit Limit** field. Notice that the message box does not open because the credit limit for this customer is above $3000. Move to record 5. Notice that the message box now opens because the credit limit for this particular customer is under $3000. Select **OK** to close the message box. Close the form window.

### Creating a Group Macro

#### Discussion

You can place multiple macros on the same macro sheet. This option, called grouping macros, has several advantages. The most obvious advantage is that it reduces the number of macros that appear in the window. More importantly, it allows you to organize your macros by grouping related macros together onto a single macro sheet. For example, if you created several macros that are related to one form, you can group all of them together on one macro sheet.

Before you can create a group macro, you need to display the **Macro Name** column in the Macro Tools window. The **Macro Name** column appears to the left of the **Action** or **Condition** column, if it is displayed. You can type the macro name directly into the appropriate field in the **Macro Name** column.

Like any other macro, a group macro must be saved with a name. You should make sure that the group macro name is descriptive enough to indicate its contents. This helps other users know what macros are contained in the group macro. For example, if all the macros relate to the **Orders** form, you could name the group macro **Order Form Macros**.

When macros are grouped, you can still refer to individual macros. To refer to an individual macro in a group, you can use its group and macro name in the format `Groupname.Macroname`. 
Creating a group macro

If you have already created macros, you can cut and paste them into a new group macro sheet or edit an existing macro sheet.

You can quickly create a group macro by dragging the desired object from the Database window to the Action column in the Macro Tools window. In doing this, the Action column and Form Name argument field are automatically filled in; you will need to type a name for the macro, however.

Procedures

1. Open the desired database.
2. Display All Access Objects on the Navigation Pane, if necessary.
3. Open the Macro Tools window.
4. Click the Macro Names button in the Show/Hide group on the Macro Tools Design tab.
5. Select the first blank field in the Macro Name column.
6. Type a name for the macro.

7. Select the corresponding field in the **Action** column next to the macro name.

8. Select the **Action** list.

9. Select the desired action.

10. Select the applicable argument in the **Action Arguments** pane.

11. Select the argument list.

12. Select the desired argument.

13. Continue to add macros to the group macro as desired.

---

**Step-by-Step**

Create a group macro.

If necessary, display **All Access Objects** in the Navigation Pane.

Open a new Macro Tools window.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Click the **Macro Names** button in the **Show/Hide** group on the **Macro Tools Design** tab. **The Macro Name column appears to the left of the Action or Condition column as appropriate.** | **XYZ**
| 2. Select the first blank field in the **Macro Name** column. **The insertion point appears in the field.** | **Click**
| 3. Type a name for the macro. **The macro name appears in the field.** | **Type** **Open entry form** |
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Select the corresponding field in the <strong>Action</strong> column next to the macro name. &lt;br&gt;The insertion point appears in the appropriate field in the <strong>Action</strong> column and an arrow appears to the right of the field.</td>
<td>Press [Tab]</td>
</tr>
<tr>
<td>5. Select the <strong>Action</strong> list. &lt;br&gt;<strong>A list of actions is displayed.</strong></td>
<td>Click <strong>Action</strong></td>
</tr>
<tr>
<td>6. Select the desired action. &lt;br&gt;<strong>The action appears in the field.</strong></td>
<td>Scroll as necessary and click <strong>OpenForm</strong></td>
</tr>
<tr>
<td>7. Select the applicable argument in the <strong>Action Arguments</strong> pane. &lt;br&gt;The insertion point appears in the appropriate argument field and an arrow appears to the right of the field.</td>
<td>Click in the <strong>Form Name</strong> argument field</td>
</tr>
<tr>
<td>8. Select the <strong>Argument</strong> list. &lt;br&gt;<strong>A list of arguments is displayed.</strong></td>
<td>Click <strong>Form Name</strong></td>
</tr>
<tr>
<td>9. Select the desired argument. &lt;br&gt;<strong>The argument appears in the argument field.</strong></td>
<td>Click <strong>Customer Sales</strong></td>
</tr>
<tr>
<td>10. Continue to add macros to the group macro as desired. &lt;br&gt;<strong>The macros appear in the Macro Tools window.</strong></td>
<td>Follow the instructions shown below the table to complete this step</td>
</tr>
</tbody>
</table>

Add the following macro to the group macro:

<table>
<thead>
<tr>
<th>Macro Name</th>
<th>Action</th>
<th>Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display phone list</td>
<td>OpenQuery</td>
<td>Query Name: Contact and Phone</td>
</tr>
</tbody>
</table>

Close and save the macro group as **Customer Sales Macros**.
CREATING AN AUTOEXEC MACRO

Discussion

While you can select a command to run a macro, you can also have a macro that runs automatically when a database is opened. This type of macro is called an Autoexec macro because it is automatically executed when the database is opened.

You can create an Autoexec macro to automate or simplify the database for other users. For example, assume that you want someone in your office to add customer orders on a specific form. To ensure that they use the correct form, you could create an Autoexec macro that opens the form for them.

You can create an Autoexec macro in two ways. You can rename an existing macro Autoexec, or you can create a new macro and save it with the name Autoexec. Since the Autoexec macro is stored with the database, each database can have its own Autoexec macro. However, you can only have one Autoexec macro per database.

You can bypass the Autoexec macro by holding the [Shift] key while you open a database.

Procedures

1. Open the desired database.
2. Display All Access Objects in the Navigation Pane, if necessary.
3. Right-click the macro name you want to rename.
4. Select Rename.
5. Type Autoexec.
6. Press [Enter].

Step-by-Step

Create an Autoexec macro by renaming an existing macro.

If necessary, display All Access Objects in the Navigation Pane.
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Right-click the macro name you want to rename.</td>
<td>Right-click Open Form</td>
</tr>
<tr>
<td><em>The Shortcut menu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select <strong>Rename</strong>.</td>
<td>Click Rename</td>
</tr>
<tr>
<td><em>The macro name appears in edit mode.</em></td>
<td></td>
</tr>
<tr>
<td>3. Type <strong>Autoexec</strong>.</td>
<td>Type <strong>Autoexec</strong></td>
</tr>
<tr>
<td><em>The text <em>Autoexec</em> replaces the old macro name.</em></td>
<td></td>
</tr>
<tr>
<td>4. Press <strong>[Enter]</strong>.</td>
<td>Press <strong>[Enter]</strong></td>
</tr>
<tr>
<td><em>The macro is renamed and repositioned alphabetically in the list of macros.</em></td>
<td></td>
</tr>
</tbody>
</table>

Close the database. Reopen **MACROS2.ACCDB** to see the macro run. Notice that the **Orders** form and the **Order Items** query open. Close the form and query windows. Close **MACROS2.ACCDB**.
EXERCISE

USING MACROS

Task

Use macros.

1. Open MACROS2X.ACCDB.

2. Rename the Open Payment/Invoice macro to Autoexec. Make sure that you press [Enter] after you rename it. Close the database and reopen it to test the macro. Notice that the two form windows open. Close the form windows.

3. The Balance macro opens a message box warning that there is a balance due for the project. Attach the Balance macro to the Balance Due text box control on the Payment Form form. Use the On Got Focus event. Close and save the form.

4. Open the Payment Form form in Form view. Click the Balance Due text box. Notice that a message box opens. Close the message box. Move through the next several records and notice that the message box opens whether or not there is a balance due. Close the form window.

5. Add a condition to the Balance macro so that the macro only runs when the balance due is greater than 0. Enter the following condition for the macro: Forms![Payment Form]![Balance Due]>0.

6. Close the Macro Design window and save the changes to the macro.

7. Open the Payment Form form in Form view. Click the Balance Due text box. Notice that a message box opens for the first record because there is a balance due (a balance greater than 0). Move through the next several records and notice that the message box only opens when a balance is due. Close the form window.

8. Create a group macro. Enter the following names, actions, and arguments in the Macro Design window:
<table>
<thead>
<tr>
<th>Macro Name</th>
<th>Action</th>
<th>Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the form</td>
<td>OpenForm</td>
<td>Form Name: Client Information Form</td>
</tr>
<tr>
<td>Open the Trainer</td>
<td>OpenTable</td>
<td>Table Name: Trainer</td>
</tr>
</tbody>
</table>

9. Save the macro as **Client Macros**. Close the Macro Design window.

LESSON 10 -
CUSTOMIZING THE NAVIGATION PANES

In this lesson, you will learn how to:

- Create custom categories
- Create custom groups
- Add database objects to a group
- Show/Hide the unassigned objects Group
- Delete objects from a group
CREATING CUSTOM CATEGORIES

Discussion

In previous versions of Access, you could use a switchboard to provide users with easy access to selected objects in your database. In Access 2007, it is easier to do so by creating a custom category using the Navigation Pane.

You can create up to a maximum of ten custom categories, each of which can contain multiple custom groups.

![The Navigation Pane Options dialog box]

Procedures

1. Open the desired database, if necessary.
2. Show the Navigation Pane, if necessary.
3. Select the arrow in the Navigation Pane header.
4. Select All Access Objects.
5. Right-click the All Access Objects category.
7. Select Add Item under the Categories List.
8. Type a name for the new category, then press [Enter].
9. Select OK.

**Step-by-Step**

From the Student Data directory, open NAVPANE.ACCDB. Create a custom category.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Show the <strong>Navigation Pane</strong>, if necessary.</td>
<td>Press [F11] to open the <strong>Navigation Pane</strong>, if</td>
</tr>
<tr>
<td><em>The Navigation Pane</em> menu is displayed.</td>
<td>necessary.</td>
</tr>
<tr>
<td>2. Select the arrow in the <strong>Navigation Pane</strong> Header.</td>
<td>Click</td>
</tr>
<tr>
<td><em>The Navigation Pane</em> menu is displayed.</td>
<td></td>
</tr>
<tr>
<td>3. Select <strong>All Access Objects</strong>.</td>
<td>Click <strong>All Access Objects</strong></td>
</tr>
<tr>
<td><em>The object type is selected, and the objects stored in it appear in the object list.</em></td>
<td></td>
</tr>
<tr>
<td>4. Right-click the <strong>All Access Objects</strong> header.</td>
<td>Right-click the <strong>All Access Objects</strong> header</td>
</tr>
<tr>
<td><em>The options menu is displayed.</em></td>
<td></td>
</tr>
<tr>
<td>5. Select <strong>Navigation Options</strong>.</td>
<td>Click <strong>Navigation Options</strong></td>
</tr>
<tr>
<td><em>The Navigation Options dialog box opens.</em></td>
<td></td>
</tr>
<tr>
<td>6. Select <strong>Add Item</strong> under the <strong>Categories</strong> list.</td>
<td>Click <strong>Add Item</strong></td>
</tr>
<tr>
<td><em>A new category appears in the <strong>Categories</strong> list.</em></td>
<td></td>
</tr>
<tr>
<td>7. Type a name for the new category, then press [Enter].</td>
<td>Type <strong>Product Info</strong>, then press [Enter]</td>
</tr>
<tr>
<td><em>The new category with its typed name appears in the <strong>Categories</strong> list.</em></td>
<td></td>
</tr>
<tr>
<td>8. Select <strong>OK</strong>.</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td><em>The Navigation Options dialog box closes.</em></td>
<td></td>
</tr>
</tbody>
</table>
Notice when you click on the header of the Navigation Pane, the new custom category now appears in the drop-down list.

---

**CREATING CUSTOM GROUPS**

**Discussion**

After you have created your custom category, you can then create one or more custom groups for that category. There is no limit to the number of custom groups you can create.

**Procedures**

1. Show the *Navigation Pane*, if necessary.
2. Right-click the *Navigation Pane* header.
3. Select *Navigation Options*.
4. Select the desired category in the *Categories* list.
5. Select the *Add Group* button under the *Groups* list for the desired category.
6. Type a name for the new group, then press [Enter].
7. Select OK.

**Step-by-Step**

Create a custom group.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Right-click the <em>Navigation Pane</em> header. <em>The Navigation Pane menu is displayed.</em></td>
<td>Right-click the Navigation Pane header</td>
</tr>
</tbody>
</table>
3. Select **Navigation Options**. 
   *The Navigation Options dialog box opens.*

4. Select the desired category in the **Categories** list. 
   *The desired category is selected.*

5. Select the **Add Group** button under the **Groups for <"category name">** list for the desired category. 
   *A new group appears in the **Groups for <"category name">** list.*

6. Type a name for the new group, then press [Enter]. 
   *The new group with its typed name appears in the **Groups for <"category name">** list.*

7. Select **OK**. 
   *The Navigation Options dialog box closes.*

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 3. Select **Navigation Options**.  
*The Navigation Options dialog box opens.* | Click **Navigation Options** |
| 4. Select the desired category in the **Categories** list.  
*The desired category is selected.* | Click **Product Info** |
| 5. Select the **Add Group** button under the **Groups for <"category name">** list for the desired category.  
*A new group appears in the **Groups for <"category name">** list.* | Click **Add Group** |
| 6. Type a name for the new group, then press [Enter].  
*The new group with its typed name appears in the **Groups for <"category name">** list.* | Type **Product Group 1**, then press [Enter] |
| 7. Select **OK**.  
*The Navigation Options dialog box closes.* | Click **OK** |

Notice when you click on the header of the Navigation Pane and select the **Product Info** category, your new custom group now appears in the drop-down list. You can repeat the above process to add as many custom groups that you need.

---

**ADDING DATABASE OBJECTS TO A GROUP**

**Discussion**

Once you have created your custom group, you can now select which objects you want to assign to it. You can select objects individually, or select multiple objects by holding down [Ctrl] as you select.

**Procedures**

1. Select the 🔽 arrow on the **Navigation Pane** header.
2. Select the desired category.
3. Select the object you want to assign from the Unassigned Objects group.

4. Drag the object to the custom group.

**Step-by-Step**

Add database objects to a group.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the arrow on the Navigation Pane header. <br> *The Navigation Pane menu is displayed.* | Click  
| 2. Select the desired category. <br> *The group(s) that you created for your category appear in the lower section of the Navigation Pane menu, together with the Unassigned Objects group.* | Click Product Info  
| 3. Select the object you want to assign from the Unassigned Objects group. <br> *A drop-down menu is displayed.* | Click the Items table  
| 4. Drag the object to the custom group. <br> *The object appears in the custom group.* | Drag the Items table to group Product Group 1  

**Practice the concept**: Add the LineItem table to Product Group 1.

Notice your actions create shortcuts to the chosen objects. You can rename the shortcuts by right-clicking them and selecting Rename Shortcut.
SHOWING/HIDING THE UNASSIGNED OBJECTS GROUP

Discussion

When you have finished creating your custom groups and have assigned your chosen objects, you can leave the Unassigned Objects group visible in the Navigation Pane, or you can choose to hide it.

Procedures

1. Show the Navigation Pane, if necessary.
2. Right-click the Navigation Pane header.
4. Check/uncheck the Unassigned Objects check box in the Groups for list, as necessary.
5. Click OK.

Step-by-Step

Show/hide the unassigned objects group.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Show the Navigation Pane, if necessary.</td>
<td>Press [F11], if necessary.</td>
</tr>
<tr>
<td>The Navigation Pane is displayed.</td>
<td></td>
</tr>
<tr>
<td>2. Right-click the Navigation Pane header.</td>
<td>Right-click the Navigation Pane header</td>
</tr>
<tr>
<td>The Navigation Pane menu is displayed.</td>
<td></td>
</tr>
<tr>
<td>3. Select Navigation Options.</td>
<td>Click Navigation Options</td>
</tr>
<tr>
<td>The Navigation Options dialog box opens.</td>
<td></td>
</tr>
</tbody>
</table>
### Steps | Practice Data
--- | ---
4. Select the desired category in the **Categories** list. The desired category is selected. | Click **Product Info**
5. Check/uncheck the **Unassigned Objects** check box in the **Groups for <“category name”>** list. The desired option is selected. | Click [Unassigned Objects] to uncheck the check box
6. Click **OK**. The Navigation Options dialog box closes, and the **Unassigned Objects** group is hidden. | Click **OK**

---

### DELETING OBJECTS FROM A GROUP

#### Discussion

You may need to change your custom groups, due to user or business demands. You can easily add or remove any objects within a group at any time.

#### Procedures

1. Select the desired category in the **Navigation Pane**.
2. Select the desired object in the desired group.
3. Press [Delete].

#### Step-by-Step

Delete objects from a group.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the desired category in the <strong>Navigation Pane</strong>. The category is displayed in the <strong>Navigation Pane</strong>.</td>
<td>Select <strong>Product Info</strong></td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
2. Select the object you want to remove in the desired group. The desired object is highlighted. | Select the Lineltem table in Product Group 1
3. Press [Delete]. The selected object is removed from the group. | Press [Delete]

Close NAVPANE.ACCDB.
EXERCISE

CUSTOMIZING THE NAVIGATION Pane

Task

Customize the Navigation Pane.

1. Open NAVPANEX.ACCDB.

2. Use the Navigation Options dialog box to create a custom category.

3. Name the custom category Client Data.

4. Within the Client Data category, create a custom group called Payment Data.

5. Close the Navigations Options dialog box.


7. Add the following objects to the Payment Data group: the Payment table and the Client/Payment query.

8. Close the database without saving.
LESSON 11 -
COLLECTING DATA BY E-MAIL

In this lesson, you will learn how to:

- Understand when to use data collection
- Use the Collect Data By E-mail Messages wizard
- Set Data Collection by E-mail options
- Manually process replies
UNDERSTANDING WHEN TO USE DATA COLLECTION

**Discussion**

Access 2007 allows you to collect data through e-mail. You can send a form using Outlook, then process the responses as you add the data collected to your database.

The following table provides examples of when to use Data Collection by e-mail:

<table>
<thead>
<tr>
<th>Surveys</th>
<th>When you want to perform a survey and compile the results in Access.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Reports</td>
<td>Team members around the world can send e-mail messages with updated status reports at regular intervals</td>
</tr>
<tr>
<td>Event Management</td>
<td>When organizing an event, such as a conference, you can send a number of forms as e-mails for gathering delegate contact information</td>
</tr>
</tbody>
</table>

In order to collect data through e-mail, you must have Access 2007 and Outlook 2007 installed on your computer.

USING THE COLLECT DATA BY E-MAIL MESSAGES WIZARD

**Discussion**

The Collect Data Through E-mail Messages Wizard guides you through the process of creating e-mail messages that include a data entry form.

Before you start the Collect Data Through E-mail Messages Wizard, you must first identify or create a table containing the fields that you want to include in your e-mail.
Before you use the Collect Data Through Email Messages Wizard, you must ensure that your recipients use an email client that supports HTML format.

Your table must contain fields that support data collection in order for the The Collect Data Through Email Messages Wizard to start.

Procedures

1. Open the desired table.
2. Click in the first empty record on your table.
3. Select the External Data tab on the ribbon.
4. Select the Create Email button in the Collect Data group on the External Data tab.
5. Read the instructions, then select Next >.
6. Select the desired type of data-entry form.

7. Select Next, then read the note after the step by step before continuing.

8. Select the desired collection options.

9. Select Next.

10. Select the fields you want to include in your form.

11. Select Next.

12. Select the desired reply processing option.

13. Select Next.

14. Select how to specify your e-mail recipients.

15. Select Next.

16. Review the subject and introduction of the e-mail message making changes, if necessary, and select Next.

17. Select Create.

18. Select your e-mail recipients by typing their e-mail addresses, or selecting them from your Outlook Address Book.

19. Select Send.

---

**Step-by-Step**

From the Student Data directory, open `DATACOL.ACCDB`.

Use the Collect Data Through E-mail Messages Wizard.

Open the **Customers** table.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click in the first empty record on your table.</td>
<td></td>
</tr>
<tr>
<td><em>The insertion point appears in the first empty record.</em></td>
<td></td>
</tr>
<tr>
<td>Click in the first empty record</td>
<td></td>
</tr>
</tbody>
</table>
### Steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 2. Select the **External Data** tab on the **Ribbon**.  
*The **External Data** tab is displayed.* | Click **External data** |
| 3. Select the **Create Email** button in the **Collect Data** group on the **External Data** tab.  
*The Collect Data Through E-mail Messages Wizard opens.* | ![Create E-mail](#) |
| 4. Read the instructions, then select **Next**.  
*The next page in the Wizard is displayed.* | Click **Next >** |
| 5. Select the desired type of data-entry form.  
*The **HTML form** option is selected.* | Click **HTML form** |
| 6. Select **Next**, then read the note after the step by step before continuing to step 7 or step 9.  
*The next page in the Wizard is displayed.* | Click **Next >** |
| 7. Select the desired collection options, if necessary.  
*The **Collect New Information Only** option is selected.* | Click **Collect New Information Only**, if necessary |
| 8. Select **Next**.  
*The next page in the Wizard is displayed.* | Click **Next >** |
| 9. Select the fields you want to include in your form  
*The desired fields are selected.* | Select **Store Name**, **Contact Name** and **Phone Number** and click [CLONE]  
**Next >** |
| 10. Select **Next**.  
*The next page in the Wizard is displayed.* | Click **Next >** |
| 11. Select the desired reply processing option.  
*The **Automatically process replies and add data to Customers** option is selected.* | Click **Automatically process replies and add data to Customers** |
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>12. Select <strong>Next</strong>.</td>
<td>Click [Next &gt;]</td>
</tr>
<tr>
<td>The next page in the Wizard is displayed.</td>
<td></td>
</tr>
<tr>
<td>13. Select how to specify your e-mail recipients.</td>
<td>Click Select how to specify your e-mail recipients.</td>
</tr>
<tr>
<td>The <strong>Enter the E-mail addresses in Microsoft Office Outlook</strong></td>
<td>Enter the e-mail addresses in Microsoft Office Outlook.</td>
</tr>
<tr>
<td><strong>option is selected.</strong></td>
<td></td>
</tr>
<tr>
<td>14. Select <strong>Next</strong>.</td>
<td>Click [Next &gt;]</td>
</tr>
<tr>
<td>The next page in the Wizard is displayed.</td>
<td></td>
</tr>
<tr>
<td>15. Review the subject and introduction of the e-mail message</td>
<td>Click [Next &gt;]</td>
</tr>
<tr>
<td>making changes, if necessary, and click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td>The Wizard displays a page informing you that you can now</td>
<td></td>
</tr>
<tr>
<td>create your e-mail messages.</td>
<td></td>
</tr>
<tr>
<td>16. Select <strong>Create</strong>.</td>
<td>Click [Create]</td>
</tr>
<tr>
<td>An Outlook message containing a data entry form is displayed.</td>
<td></td>
</tr>
<tr>
<td>17. Select your e-mail recipients by typing their e-mail</td>
<td>Type the e-mail addresses of a couple of fellow students.</td>
</tr>
<tr>
<td>addresses, or selecting them from your Outlook Address Book.</td>
<td></td>
</tr>
<tr>
<td><strong>The e-mail recipients are selected.</strong></td>
<td></td>
</tr>
<tr>
<td>18. Select <strong>Send</strong>.</td>
<td>Click [Send]</td>
</tr>
<tr>
<td>The e-mails are sent to the specified recipients.</td>
<td></td>
</tr>
</tbody>
</table>

The Wizard page that is displayed after Step 6 depends on whether the destination object supports the updating of data. If your table does not have a Primary Key field or does not contain any records, the Wizard assumes that you want to add new records, and prompts you to select the form fields. In all other cases, the Wizard prompts you to select whether you want to add or update your data before asking you to select your form fields. Continue to Step 7 or Step 9.
**SETTING DATA COLLECTION BY E-MAIL OPTIONS**

**Discussion**

When using the Collect Data Through E-mail Messages Wizard, you may want to change some collection options. Using the Collecting Data via E-mail Options dialog box you can adjust the import and automatic processing settings.

![Data Collection by E-mail Options dialog box](image)

*The Data Collection by E-mail Options dialog box*

- You can only access the Collecting Data Using E-mail Options dialog box from the **Specify How you want to process the replies** page of the Collect Data Through E-mail Messages Wizard.

**Procedures**

1. Select the **Set properties to control the automatic processing of replies** link.
2. Select desired settings and click **OK**.
Step-by-Step

Set the Collecting Data via e-mail options.

Start the Collecting Data via E-mail Wizard, and follow the steps through to the Specify how you want to process the replies page.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Set properties to control the automatic processing of replies</strong> link. The Collecting Data Using E-mail Options dialog Box is displayed.</td>
<td>Click <strong>Set properties to control the automatic processing of replies.</strong></td>
</tr>
<tr>
<td>2. Select desired settings and click OK. The settings are updated and the Collecting Data Using E-mail dialog box closes.</td>
<td>Click <strong>OK</strong></td>
</tr>
</tbody>
</table>

When the dialog box closes, Access returns to the Specify how you want to process the replies page, and you can continue using the Collecting Data Through E-mail Messages wizard.

**MANUALLY PROCESSING REPLIES**

**Discussion**

When using Data Collection by e-mail, if you want to choose when and which replies are processed, you can choose to process your replies manually. In order to manually process a reply, you have to export the data from Outlook 2007.

- In order to process replies manually, when prompted to specify how you want to process your replies by the Data Collection Through E-mail Messages wizard, make sure you clear the Automatically process replies and add data to check box.

- You can only export one reply at a time from Outlook 2007.
If you chose to have the replies processed automatically, and the process failed, you must troubleshoot the error that caused the failure before processing the replies manually.

**Procedures**

1. Open Office Outlook 2007, if necessary.
2. Right-click the reply you want to process manually.
3. Select **Export Data to Microsoft Access**.
4. Select **OK**.

**Step-by-Step**

Manually process data collection replies.

Open Office Outlook 2007, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Right-click the reply you want to process manually.  
The options drop down menu is displayed. | Right-click the reply |
| 2. Select **Export Data to Microsoft Access**.  
The Export Data to Microsoft Access dialog box opens. | Click **Export data to Microsoft Access** |
| 3. Select **OK**.  
Outlook displays a message to confirm if the export operation was successful, or if it failed. | Click **OK** |

Close **DATACOL.ACCDB**.
EXERCISE

COLLECTING DATA BY E-MAIL

Task

Collect data by email.

1. Open DATACOLX.ACCDB.
2. Open the Client table.
3. Use the Data Collection through E-mail wizard to create an email message that includes a form for collecting the following customer information: Name, Address, City, State, Zip and Phone No.
4. Choose to manually process the replies.
5. Send to the e-mail address of two of your fellow students.
6. When your recipients respond, open Outlook 2007 and manually process the replies.
LESSON 12 - EXPORTING DATA

In this lesson, you will learn how to:

- Export data to an Excel workbook
- Save Export setup
- Drag and drop data into Excel
- Create Word mail merge documents
**EXPORTING DATA TO AN EXCEL WORKBOOK**

**Discussion**

You can export database records from a database file in Access to a workbook in Excel. The Access data source can be a table, query, form, report, view, or macro. When you export data from a database, Access creates a workbook file in Excel with the data from the database. Any field names from the data source appear in the first row of the workbook.

When you export to Excel, you can choose to export to an existing workbook, or you can indicate that you want to export to a new workbook by providing a new name in the **File name** box in the Export dialog box. You can also choose to save the fonts, field widths, and data displayed from Lookup fields in your Access datasheet by selecting the **Save formatted** option before exporting.

Exporting data to Excel is a useful way to display and work with data using the capabilities of Excel. For example, you could transfer a table containing investment portfolio information to Excel in order to perform calculations on investment performance.

---

When you export to an existing Excel workbook file, the data in the workbook is deleted and replaced by the Access data, unless you are exporting to an Excel version 5.0 or later file, in which case the data is copied to the next available worksheet.

When you export a form or a table which contains a subform or subdatasheet, Access exports only the main form or table. In order to export the subform/subdatasheet, you must perform a separate export operation on each object.

---

**Procedures**

1. Select the data source you want to export.
2. Select the **External Data** tab on the **Ribbon**.
3. Select the **Excel** button in the **Export** group.

4. Select the desired file format in the **File format** box.

5. Select **Browse**.

6. Select the drive to which you want to export.

7. Open the folder to which you want to export.

8. Select **Save**.

9. Select further export options.

10. Select **OK**.

### Step-by-Step

From the Student Data directory, open **EXPORT1.ACCDB**.

Export Access data to an Excel workbook.

If necessary, display **All Access Objects** in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the data source you want to export.  
   *The data source is selected.* | Click **Reps** table |
| 2. Select the **External Data** tab on the **Ribbon**.  
   *The **External Data** tab is displayed.* | Click **External Data** |
| 3. Select the **Excel** button in the **Export** group.  
   *The Export - Excel Spreadsheet dialog box opens.* | Click **Excel** |
| 4. Select the desired file format in the **File format** box.  
   *The desired file format is selected.* | Select **Excel Workbook (.xlsx)** |
| 5. Select **Browse**.  
   *A list of available drives is displayed.* | Click **Browse**... |
Steps | Practice Data
---|---
6. Select the drive to which you want to export.  
   A list of available folders is displayed. | Click the student data drive
7. Open the folder to which you want to export.  
   A list of available files is displayed. | Double-click to select the student data folder
8. Select **Save**.  
   The Save dialog box closes, and the desired destination folder is displayed in the **File name** box. | Click ![Save](Save.png)
9. Select further export options.  
   The desired export options are selected | Click ![Export Data](Export.png) with formatting and layout
10. Select **OK**.  
    Access exports the data to Excel. | Click ![OK](OK.png)

Click **Close**, if necessary, to close the Export - Excel Spreadsheet dialog box.

Open the **REPS.XSLX** workbook in Excel. Close the workbook and Excel.

### SAVING EXPORT SETUP

**Discussion**

When exporting data from Access 2007, it is possible to save the export steps. This allows you to quickly repeat the export operation without using the wizard.

When you have completed the export operation, the **Save Export Steps** page opens. If you choose to save the export steps, you can enter a name for the export operation, or accept the default name that Access suggests. You can also add a description of the export operation, if desired.

If you regularly repeat the saved export operation, you can also create an Outlook task that reminds you when it is time to repeat the operation.
Draggging and Dropping Data into Excel

Discussion

You can drag and drop data from Access into Excel. For example, you can drag and drop tables and queries from Access and place them in a workbook in Excel. The drag and drop method is very useful when you are building information in an Excel workbook and want to use data from an Access database file in the workbook. When you drag and drop data from Access to Excel, it is best to display the two program windows side by side on the desktop.

When you drag and drop data to Excel, any formatting that has been applied to the data in Access will be lost in Excel. However, the field headings in Access are preserved in Excel.

Dragging and dropping data into Excel

Procedures

1. Open Microsoft Excel.
2. Open the desired workbook.
3. Open the desired database in Access.
4. Display the desired object list.
5. Select the Access data source you want to drag into Excel.
6. Drag the data source to the desired location in the Excel workbook.

![Step-by-Step]

Drag and drop data into Excel.

If necessary, display **All Access Objects** in the Navigation Pane.

Open a blank workbook in Excel and resize the Excel and Access windows so that they appear side by side.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Access data source you want to drag into Excel. <em>The data source is selected.</em></td>
<td>Click <strong>Line Items</strong> table</td>
</tr>
<tr>
<td>2. Drag the data source to the desired location in the Excel workbook. <em>The insertion point changes into an outline with a plus sign (+) attached when it is positioned over the Excel workbook and then the Access data appears in the Excel workbook.</em></td>
<td>Drag the <strong>Line Items</strong> table to cell A1 in the Excel workbook</td>
</tr>
</tbody>
</table>

Notice the **Line Items** table appears in the workbook in Excel. Close the workbook and Excel and do not save the changes.

Maximize the Access window.

---

**CREATING WORD MAIL MERGE DOCUMENTS**

![Discussion]

As there is no functionality in Word that can import data from Access, to export data from Access to Word, you need to work in Access. You can export tables, queries, forms or reports.
When you export an object using the Export Wizard, Access creates a copy of the object’s data in a Microsoft Word Rich Text Format file (.rtf).

You can create a mail merge operation by using the Microsoft Access Mail Merge Wizard, which enables you to set up a mail merge process that uses a table or query in Access as the data source for the merge.

### Procedures

1. Select the **External Data** tab on the **Ribbon**.
2. Click the **More** button in the **Export** group.
3. Select **Merge it with Microsoft Office Word**.
4. Select the desired export options.
5. Select **OK**.
6. Select the desired file.
7. Follow the steps in the Microsoft Word Mail Merge task pane to complete the mail merge, as desired.

### Step-by-Step

Create a Word mail merge document.

Display **All Access Objects** in the Navigation Pane, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **External Data** tab on the **Ribbon**.  
*The External Data tab is displayed.* | Click **External Data** |
| 2. Click the **More** button in the **Export** group.  
*The Export menu is displayed.* | Click **More** |
| 3. Select **Merge it with Microsoft Office Word**.  
*The Microsoft Word Mail Merge Wizard opens.* | Click **Merge it with Microsoft Office Word** |
Lesson 12 - Exporting Data

Steps | Practice Data
--- | ---
4. Select the desired export options.  
The desired export options are selected. | Click **Link your data to an existing Microsoft Word document**
5. Select **OK**.  
The Select Microsoft Word Document dialog box opens. | Click **OK**
6. Select the desired file.  
The desired file is opened in Word, and the **Mail Merge** task pane is displayed. | Double-click **MAILSHOT.DOCX** in the Student Data Folder

Once you have completed the above steps, you simply follow the standard steps in the Mail Merge task pane to create your mail merge, as desired. Close **EXPORT1.ACCDB**.
EXERCISE

EXPORTING DATA TO EXCEL AND WORD

Task

Export Access data.

1. Open EXPORT1X.ACCDB.
2. Export the Invoice table as an Excel workbook named Invoice.
3. Open Excel and the Invoice workbook that was just created.
4. Insert a new worksheet into the workbook and name it Payment.
5. Tile the Access and Excel windows.
6. Drag the Payment table in Access to cell A1 of the Payment worksheet in Excel.
7. Save and close the workbook and Excel.
## INDEX

**Charts**  
- activating Microsoft Graph, 7, 9  
- adding data labels, 15  
- adding to a form, 5, 6  
- adding to a report, 5, 6  
- changing the title, 12, 13  
- changing the type, 10, 11  
- Chart Wizard, 2, 3  
- creating, 2, 3  
- formatting the title, 13, 14

**Command buttons**  
- adding, 38, 39, 40  
- creating, 111, 112, 113

**Data Collection by E-mail, 136**  
- manually processing replies, 142, 143  
- options, 140, 141  
- using the wizard, 136, 137, 138

**Databases**  
- decrypting, 78  
- encrypting with a password, 78, 79  
- opening an encrypted database, 80

**Embedded Macros**  
- creating using the Macro Builder, 106, 107

**Excel**  
- dragging and dropping data into, 149, 150  
- exporting data to, 146, 147

**Exporting data**  
- creating a Word mail merge document, 150, 151  
- saving steps, 148

**Files**  
- removing a password, 81

**Forms**  
- converting to a split form, 35, 36  
- creating a split form, 34, 35  
- editing split forms, 36, 37  
- saving as a report, 41, 42

**Group macros**  
- creating, 117, 118, 119

**Hyperlinks**  
- creating fields, 68, 69  
- deleting fields, 73, 74  
- editing fields, 72  
- inserting fields, 70, 71  
- working with, 68

**Hypertext**  
- working with, 68
Indexes
  creating a multiple field, 59, 60
  creating a multiple field primary key, 63, 64
  creating a single field, 57, 58
  deleting, 61, 62
  viewing, 56, 57
Macro Builder
  creating embedded macros, 106, 107
Macro Tools
  Arguments, 92
Macros
  adding a condition, 114, 116
  adding an action, 88, 91
  assigning an argument to an action, 92, 95, 96
  assigning to a control, 108, 110
  creating, 88, 91
  creating Autoexec, 120, 121
  creating group, 117, 118, 119
  editing existing, 101, 102
  opening the Macro Design window, 86, 87
  running, 100, 101
  saving, 97
  using single step mode for testing, 98, 99
  working with, 86
Microsoft Graph
  activating, 7, 9
  adding chart data labels, 15
  changing the chart title, 12, 13
  changing the chart type, 10, 11
  formatting the chart title, 13, 14
Navigation Pane
  adding objects to a custom group, 129, 130
  creating a custom category, 126, 127
  creating custom groups, 128
  deleting objects from a group, 132
  show/hide unassigned objects, 130, 131
Passwords
  assigning, 78
  removing, 81
PivotChart
  creating a view, 50, 51, 52
PivotTable
  creating a view, 46, 47, 48
Primary key
  creating a multiple field, 63, 64
Properties
  using, 106
Records
  viewing in forms, 46, 50
Split form
  creating, 34, 35
Split forms
   converting existing forms, 35, 36
   editing, 36, 37
Subforms
   creating, 21, 22
   displaying a total, 27, 28, 29
   displaying in Datasheet view, 25, 26
   editing the layout, 24, 25
   working with, 20
Subreports
   creating, 21, 22
   displaying a total, 27, 28, 29
   editing the layout, 24, 25
   working with, 20